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Contact Details

Heron Instruments Inc.

447 Moxley Rd. Dundas, Ontario, L9H 5E2, Canada
Phone: 1-800-331 2032

Email: info@heroninstruments.com

Web: heroninstruments.com

Introduction

This manual covers the basic operation and use of the Heron Instruments software used to interface
with Heron’s manufactured products and services. This manual may not be fully comprehensive of all
features and capabilities. Heron Instruments is constantly working to improve its products and
therefore, feature sets and capabilities may change without notice. Features and capabilities may differ
depending on region/language/settings/etc. Methods/systems/materials used or suggested may not
comply with all regional regulations. It is the customer’s responsibility to use the software and the
manual within the limits of their regional rules and regulations.

Language Support

The Heron Instruments software is developed in English and translations are applied afterwards. The
accuracy of translations cannot be guaranteed — if in doubt, the English version should be consulted for
clarification. Further clarification can be obtained by contacting Heron Instruments directly.

Languages currently available are:

e English
e French
e Spanish

e Portuguese
e Japanese

e Hindi

e Chinese
e Bengali
e Russian

e Indonesian

If you require a language that is not listed, please contact Heron Instruments to request its addition.
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Data Protection

Data downloaded to the Heron Instruments software is stored in a local database. This database is
managed by your operating system. If the software is uninstalled or removed, the database may also be
deleted by your operating system. It is strongly recommended to back up your computer regularly to
protect your data. Backing up your database to protect against unforeseen incidents is also
recommended. Heron Instruments is not responsible for the loss of any data that may occur due to a
function or bug in the software. It is the responsibility of the user to manage their data and protect it in
a way that is commensurate.

Compatibility

The Heron Instruments software is tested on a wide variety of computer configurations; however,
compatibility is not guaranteed. To ensure the best compatibility, it is recommended to run the latest
version of Windows. This software is designed to run on Windows 10. Windows 11 (x86, x64, and ARM
compatible) and modern Apple Computers. A USB type A port with USB 2.0 or 3.0 protocols is required.
The software will run on as little as 2GB of RAM and 32GB of storage. For the best experience a
minimum of 8GB of RAM and 256GB of storage is recommended.

Installation and Updates

The software is available from the Microsoft Store or the Apple App Store. Updates are handled by
Microsoft or Apple and should be performed automatically depending on your settings.

Installing on Windows

From the overview page on the Microsoft Store, select Install. If you are signed into a Microsoft account,
your installation will happen automatically. If you are not signed into a Microsoft account, you will be
presented with an option to sign in or an option to skip. If you select skip, the software will still be
installed automatically. A Microsoft account is not required to install the software.

Once installation is complete, the software will be available on your Windows Start menu.

What You Need to Get Started

If you are connecting to a logger directly you will need the following items:

e A Windows 10, Windows 11 or modern Apple computer with the Heron Instruments
software installed.

e A compatible dipper-Log data logger.

e A compatible PC-communication cable.


https://apps.microsoft.com/detail/9N2FSKW62P22?hl=en&gl=US&ocid=pdpshare
https://apps.apple.com/app/heron-instruments/id1626339916
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Starting a New Mission

Connecting to the Software

Connect your logger to the computer using the PC-communication cable. Open the software.

When the software opens it will display all connected loggers on the top left-hand side under the
Connected dropdown menu of the Resources section. If your device is not showing up, click the

CONNECT button in the bottom left-hand corner. This will scan all ports for any Heron Instruments

devices.

ﬂ Heren Instruments

O x
Sort By: Date Modified + ~  Q Overview Data Realtime Settings
Resources &% DOWNLOAD | ~ H STOP (®) CLEAR & REMOVE DEVICE FROM PROJECT
~ @ Connected . .
o Device Information
# bar-Log 64: A15761
dipper-Log 128+: B31413 Device: dipper-Log 128+
@ Help Serial #:B31413
I catalog Range: 32.8ftH20
Max Data Sets: 128,000
Projects
Battery Lifespan: 100%
@ Add New Project o i
> M Bxample Project Memory Usage: 12%
Total Readings: 14,963 / 128,000
Status: Not on a mission
Last Mission Started: 4/9/2025 at 12:01pm
Current Pressure: 32.90799ftH20
Current Temperature: 24.469C
REFRESH MEASUREMENTS
DRIFT COMPENSATION UTILITY | | ZERO LOGGER
* Software Settings
C) CONNECT VIEW ALL
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Settings Tab

If multiple loggers are connected, select your device. The Overview tab will be displayed on default

giving an overview of your device and its current state.

To set up your logger, click on the Settings tab. This tab allows you to enter your mission details.

Note: Available settings are dependent on the logger type.

SortBy: Date Modified + ~  Q Overview Data Realtime | Settings |

Resources 4 DOWNLOAD ~ B STOP (%) CLEAR & REMOVE DEVICE FROM PROJECT

~ @ Connected

. Device Information
# bar-Log 64: A15761

dipper-Log 128+: B31413 Device: dipper-Log 128+

@ Help Serial #:B31413
Range: 32.8ftH20
Max Data Sets: 128,000

W Ccatalog

Projects

© Add New Project Battery Lifespan: 100%

> A Example Project Memory Usage: 12%

Total Readings: 14,963 / 128,000
Status: Not on a mission
Last Mission Started: 4/9/2025 at 12:01pm

Current Pressure: 32.90799ftH20
Current Temperature; 25.555C

REFRESH MEASUREMENTS

DRIFT COMPENSATION UTILITY ZERO LOGGER

¢ Software Settings

) CONNECT

VIEW ALL
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Naming a Project

Enter a Project Name and Deployment Name. These will be used to organize your data in the data
management panel under Projects. If you are adding a device to an existing project, the project name
and deployment name will be selectable as a dropdown option within the data field.

[El Heron Instruments

@ Help
W Ccatalog

Projects

Example Project

© Add New Project
> M Example Project

New York (EDT -4:00

m] X
Sort By: Date Modified + v Q Overview Data Realtime
RESRuCES Device Setup
v @ Connected

. Project Name Deployment Mame
# bar-Log 64: A15761
dipper-Log 128+: B31413
@ Help
W Catalog
[ Override Default Time Settings
Projects Time Zone
@ Add New Project New (EDT -4:00
> A Example Project
SELECT LOCATION FOR AUTOMATIC BARO COMPENSATION
< Distance to Water
Distance to Datum
60.6955658ft ~ >
a . Depth
Submerged Denth of Wat
Total Depth (optional) i epth of Water
0 ft =
e N—
HELP ME CALCULATE DISTANCE TO DATUM
# Software Settings
C) CONNECT VIEW ALL
P ified
Sort By: Date Modified + v Q Overview Data Realtime
oo Device Setup
v @ Connected
. Project Name Deployment Name
# barLog 64: A15761 ! ploymen
*
dipper-Log 128+: B31413 ‘
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Time Settings

The Time Settings default to your current location. To manually adjust the settings, click the Override
Default Time Settings box. Then select your desired time zone and daylight savings settings.

ﬂ Heron Instruments — O >

Sort By: Date Modified ¥ v Q Overview Data Realtime

Resources Device Setup

v ¥ Connected

- Project Name Deployment Name
# bar-Log 64: A15761
i #
dipper-Log 128+ B31413 Example Project Deployment #1
@ Help
M catalog
Override Default Time Settings
Projects Time Zone Daylight Savings
© Add New Project New York (EDT -4:00) - Automatic -

> # Example Project

SELECT LOCATION FOR AUTOMATIC BARO COMPENSATION

< Distance to Water
Distance to Datum

60.6955658ft ~ -

a - Depth
Submerged Depth of Wat
Total Depth (optional) i epth ot Water

0 ft

HELP ME CALCULATE DISTANCE TO DATUM
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Selecting a Location for Automatic Baro Compensation

If you would like to use the automatic barometric compensation feature on your data (for more
information see the Auto-Baro chapter), click on the SELECT LOCATION FOR AUTOMATIC BARO
COMPENSATION button. Select one of your recent locations or click on NEW LOCATION.

SortBy: Date Modified + ~  Q Overview Data Realtime

Resources Device Setup

v ¥ Connected

. Project Name Deployment Name
# bar-Log 64: A15761
[ —— Example Project Deployment #1
@ Help
M catalog
[] Override Default Time Settings

Projects me Zone Daylight Savings
@ Add New Project New York (EDT -4:00

> ™ Example Project

SELECT LOCATION FOR AUTOMATIC BARO COMPENSATION

< Distance to Water

Distance to Datum %
10 m- .
a Depth
Submerged Denth of Wat
-—
Total Depth (optional) @ epth of Water
0 m-
e N—

* Software Settings
(:) CONNECT VIEW ALL

Select Location for Automatic Baro Compensation

Recent

‘ Toronto, ON
43.64°N, -79.39°W 270ft as|
‘* Hamilton, ON
43.29°N, -80.00°W 832ft asl

‘* Hamilton, ON
43.29°N, -80.00°W 832ft asl

NEW LOCATION

If selecting a new location, start typing the address of your deployment location and select an option
from the dropdown menu. The coordinates will populate in the lower right-hand corner, then click SAVE.
Select your recently added location and click SAVE. Your deployment location will now be displayed on
the Settings tab.

Note: An active internet connection is required for this feature.

10
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New Location

447 Moxley Road

¥ 447 Moxley Road Hamilton, ON. Canada
¥ 447 Moxley Road Hawesville, KY, USA

¥ 447 Moxley Road Liberty, KY, USA

¥ 447 Moxley Road Bainbridge, OH, USA

¥ 447 Moxley Road Hays. NC, USA

powered by Google|

Hamilton, ON
43.29°N, -80.00°W 823ft asl

ﬂ Heron Instruments

Sort By: Date Modified ¥+ v Q

Overview Data

Realtime

Resources Device Setup

v ® Connected

- Project Name
# bar-Log 64: A15761 :

dipper-Log 128+: B31413 Example Project
@ Hep

M Catalog
[C] Override Default Time Settings
Projects

© Add New Project (EDT -4:00)

> M Example Project

‘* Hamilton, ON
43.28°N,-80.00°W 832ft asl

Deployment Name

Deployment #1

Automatic

SELECT LOCATION FOR AUTOMATIC BARO COMPENSATION

11
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Distance to Datum

The Distance to Datum measurement is the distance between where the device is deployed and your
datum point (e.g. the top of the well casing). This field is mandatory. If you have a dipper-Log on a direct
read cable or a Heron water level meter, you can click on the HELP ME CALCULATE DISTANCE TO DATUM
button. This tool is a useful step-by-step guide to calculate your Distance to Datum measurement.

Sort By: Date Modified ¥~ Q Overview Data Realtime

Resources

« @ Comnected (EDT -4:00) Automatic

#° bar-Log 64 A15761

dipper-Log 128+: B31413

SELECT LOCATION FOR AUTOMATIC BARO COMPENSATION

@ Help
I catalog ‘ Hamilton, ON
43.29°N,-80.00°W 832ft asl

Projects by
@ Add New Project
2 L FEnTRET < Distance to Water

Distance to Datum

50 m - -

a . Depth
Submerged Denth of Wat
Total Depth (optional) i epth ot Water
0 m -
e S —

HELP ME CALCULATE DISTANCE TO DATUM

o

(® Immediate start () Future start

* Software Settings

(:) CONNECT VIEW ALL

Calculate Distance from Datum X

This tool will help you calculate your distance from datum if:
= You have a dipper-Log on direct read cable
* You have a water level meter like a Heron dipper-T

Step 1
Stay connected to your logger and remove it from the water.

CONFIRM REMOVAL

Step 2
Deploy your logger ensuring it is submerged.

Step 3
Take a water level meter reading.

1 ft «

CANCEL

12
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Total Depth

Total Depth is optional but recommended. It is the distance from the datum point to the bottom of the
well or body of water being measured. The software can use the total depth to automatically calculate
more information and save you from additional work.

Use a Heron dipper-T2 with the optional well depth indicator probe to get an accurate reading of the
depth of your water column.

Sort By: Date Modified + ~  Q Overview Data Realtime

Resources me Zone

~ @ Connected

# bar-log 64: A15761

dipper-Log 128+: B31413

SELECT LOCATION FOR AUTOMATIC BARO COMPENSATION

© Help
I catalog ‘ Hamilton, ON
43.29°N, -80.00°W 832ft asl

Projects %
@ Add New Project
o T Bl R < Distance to Water

Distance to Datum

20 m = -

- Depth
Submerged Depth of Wat
—
Total Depth (optional) @ epth of Water
0 m «
e
HELP ME CALCULATE DISTANCE TO DATUM
® Immediate start () Futurestart | 8/5/202511:40:15

* Software Settings
(:) CONNECT VIEW ALL

13
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Start Time

By default, the logger is set to start its mission immediately. To input a future start date and time, check
the Future Start box and edit the date and time by clicking in the date/time field.

Sort By: Date Modified + ~  Q Overview Data Realtime

< Distance to Water
Resources Distance to Datum

v § Connected
. 60.6955658ft ~ +
# barlLog 64: A15761

dipper-Log 128+: B31413 ] o Depth
pperiog . Submerged

«— Depth of Water

@ Help Total Depth (optional) i
Catalof
2 ¢ 0 ft =
A e N—
Projects

@ Add New Project
> M Example Project

HELP ME CALCULATE DISTANCE TO DATUM

@® Immediate start () Futurestart | 8/5/202502:03:170m

The dipper-Log will take a reading every

5 Seconds «

dipper-Log will stop on 8/12/2025 at 11:49pm

START NEW MISSION

(:) CONNECT VIEW ALL

* Software Settings

14
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Logging Intervals

Most loggers only support linear reading intervals — however, some will also support scheduled

intervals. Select the Linear or Scheduled tab.

Linear Mode

Linear mode allows you to set the amount of time between each reading. Some loggers may also allow
you to select a maximum number of readings.

Sort By: Date Modified ¥+ ~ Q

Resources

~v @ Connected

' bar-Log 64: A15761

dipper-Log 128+: B31413
@ Help
I Catalog

Projects

© Add New Project
> A Example Project

* Software Settings

) CONNECT

Overview Data Realtime

< Distance to Water
Distance to Datum

50 m~ "

Depth
—
Submerged

Total Depth (optional) & <= Depth of Water

0 m -

HELP ME CALCULATE DISTANCE TO DATUM

@® Immediate start () Futurestart | £/5/202501:42:24pm

The dipper-Log will take a reading every

2 Hours -

dipper-Log will stop on 10/19/2054 at 2:00am

START NEW MISSION

VIEW ALL

Note: The software displays the logger’s estimated stop time based on its current storage and the

reading interval.

The dipper-Log will take a reading every

2 Hours =

dipper-Log will stop on 10/19/2054 at 2:00am

15




Log Time records the first reading at 1 second and adds 1 second to each subsequent reading interval for
255 readings. Note: This feature is supported by some but not all loggers.

Linear

The dipper-Log will take a reading every

Log Time «

dipper-Log will stop on 8/5/2025 at 10:42pm

Scheduled Mode

The Scheduled mode allows you to create a custom logging schedule for your logger. This mode is highly
flexible and can be as simple or complex as required. Create an interval and input a maximum number of
readings for that interval. Click the (+) button to add more intervals and use the (-) button to remove
intervals. After creating your schedule, select whether your mission will stop at the end of the schedule
or if the schedule will repeat.

The dipperLog will take a reading every Hours
1. 15 Minutes for 10 Intervals 2.5 ()
2. 1 Seconds for 100 Intervals 0.03 (]

€@  Add Interval (Maximum 50 Intervals)

After Schedule Completion
(®)  stop After Schedule Gompletion
(O Repeat Schedule Times

dipperLog will stop on 2021-09-16 at 12:52pm

Total Time: 2.53 hours
Total Readings: 110

16
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Checks Before Starting the Mission

Starting a new mission will delete any data stored on the logger! Make sure to download your data

before starting a new mission — data downloaded to the database on your computer will not be
affected. Starting a new mission will also overwrite the previous mission settings.

Once all settings are entered, click the START NEW MISSION button. This will upload your settings to the
logger, and it will now appear in your data management panel under the appropriate project and

deployment. You can now disconnect your logger and deploy it.

Sort By: Date

odified ¥ «

Resources
~v @ Connected
# barlog 64: A15761
# dipper-Log 128+ B31413
9 Help
I catalog

Projects
@ Add New Project
@ Add Deployment
> Q@ Heron Water Well

v @ Deployment #1
B notes
B Manual Entry
=2 Auto-Baro

vd

* Software Settings

(» CONNECT

Data
4 DOWNLOAD | ~ | m STOP
Device Information

Device: dipper-Log 128+
Serial #: 831413

Range: 32.8ftH20

Max Data Sets: 128,000

Battery Lifespan: 100%

Memory Usage: 0%

Memory will be full: 10/19/2054
Total Readings: 1/ 128,000
Current Mission Started: 8/5/2025 at 2:20pm

Current Pressure: 32.843461tH20
Current Temperature: 24.453C

Realtime

Settings

VIEW ALL

17
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Downloading Data

Connecting the Logger

Connect your logger to the computer using the PC-communication cable. Open the software.

When the software opens it will display all connected loggers on the top left-hand side under the
Connected dropdown menu of the Resources section. If your device is not showing up, click the

CONNECT button in the bottom left-hand corner. This will scan all ports for any Heron Instruments

devices.

ﬂ Heren Instruments

O x
Sort By: Date Modified + ~  Q Overview Data Realtime Settings
Resources &% DOWNLOAD | ~ H STOP (®) CLEAR & REMOVE DEVICE FROM PROJECT
~ @ Connected . .
o Device Information
# bar-Log 64: A15761
dipper-Log 128+: B31413 Device: dipper-Log 128+
@ Help Serial #:B31413
I catalog Range: 32.8ftH20
Max Data Sets: 128,000
Projects
Battery Lifespan: 100%
@ Add New Project o i
> M Bxample Project Memory Usage: 12%
Total Readings: 14,963 / 128,000
Status: Not on a mission
Last Mission Started: 4/9/2025 at 12:01pm
Current Pressure: 32.90799ftH20
Current Temperature: 24.469C
REFRESH MEASUREMENTS
DRIFT COMPENSATION UTILITY | | ZERO LOGGER
* Software Settings
C) CONNECT VIEW ALL

18
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Find the logger in the data management panel under Projects and click on the device.

Note: Connected devices will have a green logger icon, while disconnected devices will have a black

logger icon.

Sort By: Date Modified ¥+ ~ Q

Resources

~v @ Connected

# barlog 64: A15761

# dipper-Log 128+ B31413
@ Help
I catalog

Projects

© Add New Project
~ A Example Project
© Add Deployment
w 9 Heron Water Well
B notes
. Manual Entry
=2 Auto-Baro
- # dipper-Log Vented+: B50603
v 9 Deployment #1
B Notes
. Manual Entry
=2 Auto-Baro
dipper-Log 128+: B31413

* Software Settings

) CONNECT

Overview Data

Realtime

Settings

# DOWNLOAD | ~ m STOP (®) CLEAR & REMOVE DEVICE FROM PROJECT

Device Information

Device: dipper-Log 128+
Serial #: 831413

Range: 32.8ftH20

Max Data Sets: 128,000

Battery Lifespan: 100%

Memory Usage: 0%

Memory will be full: 10/19/2054
Total Readings: 1 /128,000
Current Mission Started: 8/5/2025 at 2:31pm

Current Pressure: 32.843461tH20
Current Temperature: 24.367C

REFRESH MEASUREMENTS

DRIFT COMPENSATION UTILITY ZERO LOGGER

VIEW ALL

19
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Downloading the Data

Click the DOWNLOAD button and your data will begin downloading.

Sort By: Date Modified v ~ Q

Overview

# DOWNLOAD | ~

Device Information

Data Realtime Settings

Resources M STOP | (® CLEAR & REMOVE DEVICE FROM PROJECT

~v @ Connected
' dipper-Log 128+: B31413

# barLog 64: A15761 Device: dipper-Log 128+
@ Help Serial #: 831413
K] Catalog Range: 32.8ftH20
Max Data Sets: 128,000
Projects
Battery Lifespan: 100%
o Add New Project "
~ A Example Project Memory Usage: 0%
© ~dd Deployment Total Readings: 194 / 128,000
» @ Heron Water Well Status: Not on a mission
~ @ Deployment #1 Last Mission Started: 8/5/2025 at 2:45pm
B notes
Current Pressure: 32.83988ftH20
. Manual Entry

Current Temperature: 24.328C
=2 Auto-Baro

" REFRESH MEASUREMENTS
dipper-Log 128+: B31413

DRIFT COMPENSATION UTILITY ZERO LOGGER

* Software Settings

l‘:) CONNECT VIEW ALL

Downloading...

nloading... (~a few seconds remaining)

While you wait m
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Viewing and Refining the Data

Data Tab

Navigate to the desired device in the data management panel under Projects. Select the device and click
on the Data tab. Note: Your device does not need to be actively connected if the data was previously
downloaded.

A view of all the downloaded data will be displayed.

Sort By: Date Modified v~ Q Overview Realtime Settings
Resources Deployment #1 dipper-Log 128+ plot
24.400 32.8450
~ @ Connected
# dipper-Log 128+: B31413
# bar-Log 64: A15761
@ Help N §
I catalog g z
Projects % 24350 | 2 328400
© Add New Project § i
2 =
s~ M Example Project 2
@ Add Deployment
> Q@ Heron Water Well
v 9 Deployment #1
B Notes 24300 32.8350
8/5/2025 2:46.00pm 8512025 2:48.00pm 8/5/2025 2:50.00pm 81512025 2:52:00pm
. Manual Entry
SELECT DATA RANGE Select bar-Log « MORE TOOLS Data = as CsSV «
= Auto-Baro
dipper-Log 128+ B31415 # Date & Time Total Pressure ~ | @ | fiH20 ~ | [} Temperature| °C ~ | [l
1 8/5/2025 2:45:53pm 32.84346 24.352
2 8/5/2025 2:45:55pm 32.83988 24.359
3 8/5/2025 2:45:57pm 32.84346 24.359
4 8/5/2025 2:45:59pm 32.84346 24.359
5 8/5/2025 2:46:01pm 32.83988 24.359
6 8/5/2025 2:46:03pm 32.83988 24.359
7 8/5/2025 2:46:05pm 32.83988 24.367
8 8/5/2025 2:46:07pm 32.84346 24.367
9 8/5/2025 2:46:09pm 32.83988 24.367
10 8/5/2025 2:46:11pm 32.83988 24.367
11 8/5/2025 2:46:13pm 32.83988 24.375
12 8/5/2025 2:46:15pm 32.83988 24.375
13 8/5/2025 2:46:17pm 32.84346 24.375
14 8/5/2025 2:46:19pm 32.83988 24.375
* Software Settings 15 8/5/2025 2:46:21pm 32.84346 24.375
(:) CONNECT VIEW ALL
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Viewing Specific Data Points on the Graph

By default, all parameters will be visible on the graph. Hover over the graph (or click and drag on touch
screen devices) to see details of specific data points. Clicking on the graph will highlight the
corresponding data point in the table. Clicking and dragging will select a region on the graph and the
corresponding data points will be highlighted in the table.

Realtime Settings

Resources

24.400
~ ¥ Cconnected

" dipper-Log 128+ B31413
# bar-Log 64: A15761

ﬂ Help

M Catalog

. 24350
Projects

Temperature (°C)

Q Add New Project

~ M Example Project
° Add Deployment
> Q Heron Water Well
v 9 Deployment #1

B notes

24300

32.8450

32.8400

Total Pressure (H20)

32.8350
8/5/2025 2:46:00pm

Resources Deployment #1 dipper-Log 128+ plot
24.400 32.8450
~v @ Connected
# dipperLog 128+ B31413
# bariog 64: 15761 /512025 2:49:35pm
B Total Pressure (fH20): 32.843
@ el =) [l Temperature (“C): 24.359 J
W0 catalog % TRy
3
Projects 24350 | 3 328400
° ‘Add New Project ETL:
v A& Example Project 2
© Add Deployment
> 9 Heron Water Well
v 9 Deployment #1
B notes 24.300 32.8350
8/5/2025 2:46:00pm 8/5/2025 2:48:00pm 8/5/2025 2:50:00pm 8/5/2025 2:52:00pm
. Manual Entry
SELECT DATARANGE | | Select bar-Log ~ | | MORETOOLS Data v | as CSV v
= Auto-Baro
# Date & Time Total Pressure ~ | @ | ftH20 ~ |l Temperature. °C ~ | [l
132 8/5/2025 2:50:15pm 32.83988 24.352
133 8/5/2025 2:50:17pm 32.83988 24.352
134 8/5/2025 2:50:19pm 32.83988 24.352
135 8/5/2025 2:50:21pm 32.83988 24.352
136 8/5/2025 2:50:23pm 32.83988 24.352
137 8/5/2025 2:50:25pm 32.83988 24352
138 8/5/2025 2:50:27pm 32.83988 24.352
139 8/5/2025 2:50:29pm 32.84346 24.344
140 8/5/2025 2:50:31pm 32.83988 24352
41 8/5/2025 2:50:33pm 32.83988 24.344
142 8/5/2025 2:50:35pm 32.83988 24.352
143 8/5/2025 2:50:37pm 32.83988 24352
144 8/5/2025 2:50:39pm 32.83988 24.352
145 8/5/2025 2:50:41pm 32.83988 24.344
n Software Settings 146 8/5/2025 2:50:43pm 32.83988 24352
‘ ) CONNECT ‘ VIEW ALL ‘

Deployment #1 dipper-Log 128+ plot

—

8/5/2025 2:48:00pm

8/5/2025 2:50:00pm

8/5/2025 2:52:00pm

* Software Settings

8/5/2025 07pm
8/5/2025 2:46:09pm
8/5/2025 11pm
8/5/2025 2:46:13pm
8/5/2025 15pm
8/5/2025 2:46:17pm

8/5/2025 2:46:23pm

8/5/2025 25pm
8/5/2025 2:46:27pm

B Manual Entry SELECT DATARANGE | | Select bar-Log ~ | | MORE TooLs Data~ as| CSV v
= Auto-Baro # Date & Time Total Pressure ~ | @ | ftH20 ~ ||l Temperature. °C ~ [l
6 8/5/2025 2:46:03pm 32.83988 24359
7 8/5/2025 2:46:05pm 32.83988 24.367
8

24.383

‘ ) CONNECT

VIEW ALL
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Delete unwanted data points by selecting them in the table, right-clicking and pressing delete. Note:
This action cannot be undone — deleted data cannot be recovered.

Sort By: Date Modified ¥+ ~ Q

Resources

~ @ Connected
' dipper-Log 128+ B31413
# bar-Log 64: A15761

e Help

W catalog

Projects

24 400

24350

© Add New Project
v A Example Project
e Add Deployment
> @ Heron water Well
v @ Deployment #1
B notes
. Manual Entry
= Auto-Baro

Temperature ("C}

24300

SELECT DATA RANGE

#

dipper-Log 128+: B31413 o

24

ﬂ Software Settings

) CONNECT

Realtime Settings

Deployment #1 dipper-Log 128+ plot
328450

328400

Total Pressure {tH20)

328350
8/5/2025 2:46:00pm 8/5/2025 2:48:00pm

MORE TOOLS

8/5/2025 2:50:00pm 8/5/2025 2:52:00pm

EKPDRT Data v | as | CSV ~

Select bar-Log ~
Date & Time
8/5/2025

pm 32,3988 24.383
| 8/5/202524637pm | 3284346 | 24383 | |
| 8/5/2025246:3%m | 3283988 | 24383 | |
3283988 . o433 ||
3283088 235
32.83988 24.375
32.83988 24375
8/5/2025 2:46:49pm 32.83988 24.375
8/5/2025 2:46:51pm 32.83988 24.375
8/5/2025 2:46:53pm 32.83088 24.375
8/5/2025 2:46:55pm 3283088 24.375
8/5/2025 2:46:57pm 32.83088 24375
8/5/2025 2:46:59pm 32.83988 24375
8/5/2025 2:47:01pm 32.83988 24.375
VIEW ALL

Changing the Graph Title

Click on the title at the top of the graph and enter the new title in the pop-up window. Click the RESET

button to return to the default title.

Enter a New Name for This Graph X

Deployment #1 dipper-Log 128+ plot

RESET SAVE
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Modifying the Parameters Shown on the Graph and their Colours

Modify the parameters shown in the graph by selecting/deselecting the columns in the chart.

Resources

v ¥ connected
# dipper-Log 128+ B31413
# bar-Log 64: A15761

@ Help

I catalog

Projects

© Add New Project
~ & Example Project
© Add Deployment
> Q@ Heron Water Well
~ @ Deployment #1
2 Notes
. Manual Entry
= Auto-Baro

dipper-Log 128+: B31413

Q Software Settings

) CONNECT

328450

32.8400

Total Pressure (ftH20)

328350

Sort By: Date Modified ¥ v Q overview Dalu

8/5/2025 2:46:00pm

SELECT DATA RANGE

Select bar-Log +

Realtime

Settings

Deployment #1 dipper-Log 128+ plot

# Date & Time

| 102 8/5/2025 2:49:15pm
103 8/5/2025 2:49:17pm
104 8/5/2025 2:49:19pm
105 8/5/2025 2:49:21pm
106 8/5/2025 2:49:23pm
107 8/5/2025 2:49:25pm
108 8/5/2025 2:49:27pm
109 8/5/2025 2:49:29pm
110 8/5/2025 2:49:31pm
11 8/5/2025 2:49:33pm
112 8/5/2025 2:49:35pm
113 8/5/2025 2:49:37pm
114 8/5/2025 2:49:39pm

8/6/2025 2:48:00pm 8/5/2025 2:50:00pm 8/5/2025 2:52:00pm
MORE TOOLS Data v |as | CSV =
Total Pressure ~ | @ [ ftH20 ~ | E Temperature -

32.83988 24.367 ]
32.83988 24.359
32.83988 24.359
32.83988 24.367
32.83988 24.359
32.83988 24.359
32.83988 24.359
32.83988 24.359
32.83988 24.359
32.83988 24.359
32.84346 24.359
32.83988 24.367
32.83988 24.359

VIEW ALL

Change the line colour on the graph by selecting the colour swatches in the chart header. Choose a

colour and the graph will be updated to reflect your new selection.

Realtime

Settings

Resources

v @ Connected
# dipper-Log 128+: B31413
' barLog 64: A15761

@ Help

M catalog

Projects

24 400

24350

© Add New Project

~ & Example Project
© Add Deployment
> @ Heron Water Well
v Q Deployment #1

Temperature (°C)

24300

32 8450

32.8400

Total Pressure (ffH20)

32.8350

Deployment #1 dipper-Log 128+ plot

8/5/2025 2:46:00pm 8/5/2025 2:48:00pm 8/5/2025 2:50:00pm 8/5/2025 2:52:00pm
B notes SELECT DATA RANGE Select bar-Log ~ MORE TOOLS Data v+ (as CSV +
® vanual Enry # Date &Ti @ | TotalP @ [ 20 - | wre| °c - [ «
ate ime ) otal Pressure - - iperature -
=% Auto-Baro - . . . £
- 120 8/5/2025 2:49:51pm 32.83988 EEE 24.359
121 8/5/2025 2:49:53pm 32.83988 | | 24359
122 8/5/2025 2:49:55pm 32.83988 BEE 3=
123 8/5/2025 2:49:57pm 32.83088 T 1 PEED
124 8/5/2025 2:49:59pm 32.83088 | | 24359
125 8/5/2025 2:50:01pm 32.83088 "HEDR s
126 8/5/2025 2:50:03pm 32.83988 24.352
127 8/5/2025 2:50:05pm 32.83988 | L L 24352
128 8/5/2025 2:50:07pm 32.83988 24.352
129 8/5/2025 2:50:09pm 32.83988 24352
130 8/5/2025 2:50:11pm 32.83988 24.352
131 8/5/2025 2:50:13pm 32.84346 24.359
LX software Settings 132 8/5/20252:50:15pm 32.83988 ]
w’:) CONNECT VIEW ALL
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Changing the Units

Click on the units in the chart header and a dropdown menu will appear. All the data points and the
graph will automatically update when a new unit is selected.

Resources

v @ Connected
# dipper-Log 128+: B31413
' barLog 64: A15761

@ Help

M catalog

Projects

© Add New Project
~ #& Example Project
© Add Deployment
> Q Heron Water Well
v Q Deployment #1
B notes
. Manual Entry
= Auto-Baro

dipper-Log 128+: B31413

# Software Settings

) CONNECT

Realtime

Settings

Deployment #1 dipper-Log 128+ plot

24.400 32.8450
o

3 2

= =

% 24.350 % 32.8400

g i

= =

ks
24.300 32.8350
8/5/2025 2:46:00pm 8/5/2025 2:48:00pm

SELECT DATA RANGE Select bar-Log ~ MORE TOOLS

# Date & Time Total Pressure « 07
120 8/5/2025 2:49:51pm 32.83988 :
121 8/5/2025 2:49:53pm 32.83988
122 8/5/2025 2:49:55pm 32.83988
123 8/5/2025 2:49:57pm 32.83988
124 8/5/2025 2:49:59pm 32.83988
125 8/5/2025 2:50:01pm 32.83988
126 8/5/2025 2:50:03pm 32.83988
127 8/5/2025 2:50:05pm 32.83988
128 8/5/2025 2:50:07pm 32.83988
129 8/5/2025 2:50:09pm 32.83988
130 8/5/2025 2:50:11pm 32.83988
131 8/5/2025 2:50:13pm 32.84346

| 132 | 8/5/2025 2:50:15pm 32.83988

atm
mbar
bar
mmH20
cmH20
cmHg
ftH20
hPa
inH20
inHg
kgf/em?
kgf/m?
KPa
MPa

mH20

mmHg

N/m?

psi

8/5/2025 2:50:00pm 8/5/2025 2:52:00pm

CSV ~

Data v | as

VIEW ALL
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Filtering the Data Range

Refine your data by clicking on the SELECT DATA RANGE button. In the pop-up window you can filter
your data by a date range or the download date and apply upper and lower limits to the Y-axis.

SortBy: Date Modified v = Q Overview Data Realtime Settings
Resources Deployment #1 dipper-Log 128+ plot
24 400 32,8450
v ¥ Connected
# dipper-Log 128+ B31413
# bar-Log 64: A15761 5
s g
@ Help e z
K Catalog 34350 | 3 32.8400
Projects E
@ Add New Project =
~ A Example Project
© Add Deployment 24300 32,8350
> @ Heron water well 8/5/2025 2 46-00pm 2/5/2025 2-423 00pm 8/5/2025 250 00pm 2/5/2025 2 52-00pm
~ @ Deployment #1 Selectbar-Log ~ || MORETOOLS Data v as| CSV v
B notes # Date & Time Total Pressure ~ | @ | ftH20 ~ |} Temperature| °C ~ | [}
B vanual Entry 1 8/5/2025 2:45:53pm 32.84346 24352
= Auto-Baro 2 8/5/2025 2:45:55pm 32.83988 24.359
3 8/5/2025 2:45:57pm 32.84346 24.359
4 8/5/2025 2:45:59pm 32.84346 24.359
5 8/5/2025 2:46:01pm 32.83988 24.359
6 8/5/2025 2:46:03pm 32.83988 24.359
7 8/5/2025 2:46:05pm 32.83988 24,367
8 8/5/2025 2:46:07pm 32.84346 24.367
9 8/5/2025 2:46:09pm 32.83988 24.367
10 8/5/2025 2:46:11pm 32.83988 24.367
11 8/5/2025 2:46:13pm 32.83988 24375
& software settings 12 8/5/2025 2:46:150m 32.83988 24375
) CONNECT VIEW ALL

To enter a specific date range, go to the By Date Range tab, input a start and end date. Hitting RESET will
set the date range to cover all data points available (the default setting). Clicking on REMOVE FILTER will
remove the filter entirely. To filter the data to a specific download date, go to By Download Date tab and
select a download date from the dropdown list.
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Filter by Date

BY DATE RANGE BY DOWNLOAD DATE

Start

11/14/2024 06:13:00am

End
11/18/2024 06:58:00am

REMOVE FILTER

Define Y Axis

[ Apply upper and lower pressure limits

m Displa

ftH20

[ Apply upper and lower temperature limits

num Dis|

Filter by Date

BY DATE RANGE BY DOWNLOAD D
Download Date
[Select aDate

Select a Date

11/20/2024 at 2:58pm

“DEIME ¥ AXIS

[ Apply upper and lower pressure limits

m Displaved Press

ftH20

[ Apply upper and lower temperature limits
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To define upper and lower parameter limits, check the applicable box under Define Y Axis. Input a
maximum and minimum value and select your units. Note: the units do not need to match the units
selected in the chart; they will be converted automatically.

Filter by Date

BY DATE RANGE BY DOWNLOAD DATE

Start
11/14/2024 06:13:00am

End
11/18/2024 06:58:00am

REMOVE FILTER

Define Y Axis

@Apply upper and lower pressure limits

Apply upper and lower temperature limits

Maximum Displayed Temperature *

10

Minimum Displayed Temperature *

0

Click DONE once you have added your desired filters and the table and graph will update. A bar will
appear indicating that some of your data is hidden. Use the Click here button to view your unfiltered
data.

SELECT DATA RANGE Select bar-Log ~ MORE TOOLS EXPORT Data as CSV ~

Some data is hidden. Click here to view all I

# Date & Time Total Pressure ~ | @ | ftH20 ~ . Temperature °C ~ -
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Pressure Loggers

When using a pressure logger, the default header will be Total Pressure. You can select alternatives by
clicking on the header and selecting an option from the drop-down menu.

SortBy: Date Modified v = Q Overview Data Realtime Settings
Resources Deployment #1 dipper-Log 128+ plot
24,400 32 8450
v ¥ Connected
/' dipper-Log 128+ B31413
/' bar-Log 64: A15761
@ Help =)
o <
I catalog = =
. 24350 % 32 8400
Projects 3 8
3 I
@ Add New Project 2 =
~ A Example Project -
@ Add Deployment
> @ Heron water well
v @ Deployment 1 24300 32.8350
B Notes 8/5/2025 2°45-00pm 8/5/2025 2-48 00pm 8/5/2025 2°50-00pm 8/5/2025 252 00pm
B Manual Entry SELECT DATA RANGE || Selectbar-Log ~ | | MORE TooLs Data v as| CSV ~
= Auto-Baro # Date & Time * b fiHzo ~ | Temperature| °C ~ | [
138 8/5/2025 2:50:27pm | 3 24.352
139 8/5/2025 2:50:29pm | Distance to Water 4 24.344
140 8/5/2025 2:50:31pm 3 24.352
141 8/5/2025 2:50:33pm | DepthofWater 4 24.344
142 8/5/2025 2150135;}!’!’1 | Total Pressure _3 24.352
143 8/5/2025 2:50:37pm 3 24.352
144 8/5/2025 2:50:39pm FPBSSH 24.352
145 8/5/2025 2:50:41pm 32.83988 24,344
146 8/5/2025 2:50:43pm 32.83988 24,352
147 8/5/2025 2:50:45pm 32.83988 24.352
148 8/5/2025 2:50:47pm 32.83988 24.344
149 8/5/2025 2:50:49pm 32.83988 24.344
L software Settings [ 150 | 8/5/20252:50:51pm 32.83088 24.344 ]
) CONNECT VIEW ALL

Total Pressure: The raw pressure values measured by the pressure transducer.

Depth Submerged: The vertical distance from the water’s surface to the logger’s pressure transducer.

Depth Submerged = Total Pressure — Barometric Pressure*

*See the following section (Barometric Pressure Compensation) to select the source for barometric
pressure

Distance to Water: The vertical distance from your datum point to the water’s surface

Distance to Water = Distance to Datum — Depth Submerged

Depth of Water: The vertical distance from the water’s surface to the bottom of the body of water.
*Only available if Total Depth has been entered*

Depth of Water = Total Depth — Distance to Water
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-

Distance to Datum
0 ft « *

" -—
Total Depth (optional) i
0 ft =

. v

Distance to Water

Depth

Submerged

+— Depth of Water

Barometric Pressure Compensation

There are three sources of barometric pressure that can be used to compensate your data: Auto-Baro, a
bar-Log or a manual entry. Click on the Select bar-Log button to view a dropdown menu of the options.

¢ CONNECT

Resources Deployment #1 dipper-Log 128+ plot
24.400 0.6050
v @ Connected
# dipper-Log 128+ B31413
/' bar-Log 64: A15761 g
— I
@ Help £ f
I Catalog ;;: 24350 E’ 0.6000
Projects E @
= =
© Add New Project 2
> M Timbe
~ M Example Project
24300 05950
© Add Deployment B/5/2025 2.45.000m) 8/5/2025 2:48 00pm 8/5/2025 250-00pm 8/5/2025 2:52-00pm
> Q@ Heron Water well SELECT DATA RANGE ||| Select bar-Log ~ || mMOReE TooOLS Data ~  as| CSV =
~ @ Depl it #1 i I
; S # Date & None Depth Submerged ~ Q ftH20 ~ . Temperature  °C = .
Not - -
8 oes 1 8/ 0.60224 24352
Manual Ent 1
T E 2 8/F auto-Baro 0.59865 24.359
= Auto-Baro 3 8/p 0.60224 24.359
> 4 8/] 0.60224 24.359
| -
5 g/p Otherbar-Log's 0.59865 24.359
6 8F Enter value 0.59865 24.359
7 8/p ] 0.59865 24.367
8 8/37207s5 ZZoo7pm. 0.60224 24.367
9 8/5/2025 2:46:09pm 0.59865 24.367
10 8/5/2025 2:46:11pm 0.59865 24.367
11 8/5/2025 2:46:13pm 0.59865 24.375
I software Settings 12 8/5/2025 2:46:15pm 0.59865 24.375

VIEW ALL
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Auto-Baro

Select Auto-Baro from the dropdown list. This will automatically compensate your data based on the
location chosen in device setup. For more information on the Auto-Baro feature please see the Auto-
Baro chapter.

Bar-Log

Select Other bar-Log’s from the dropdown list. In the pop-up window, select the desired bar-Log. To
view other dipper-Logs, check the Show dipper-Logs box. This allows you to select a dipper-Log to
compensate your data—however, this is not recommended.

Manual Entry

Select Enter Value from the dropdown list. Input a barometric pressure value and select the units (they
do not need to match the table units).

The field box will indicate which compensation source you are using. To remove a source, click on the field
box and select None.

If no source is selected, the software will use the back-up barometric pressure/programmed value stored
in the logger (from zeroing the logger) to calculate depth submerged.

Sort By: Date Modified + »  Q, Overview Data Realtime Settings
Resources Deployment #1 dipper-Log 128+ plot
24.400 -0.6100
~ @ Connected
# dipper-Log 128+ B31413
# barlog 64: A15761 §
@ Help g £
) Catalog £ 24350 Ef -0.6150
Projects g E
= =
@ Add New Project E
> A Timbe
w # Example Project
@ Add Deployment 24.300 -0.6200
8/5/2025 2:46:00pm 8/5/2025 2:48:00pm 8/5/2025 2:50:00pm 8/5/2025 2:52:00pm
> Q@ Heron Water Well
SELECT DATA RANGE Baro Value: 100KPa = MORE TOOLS EXPORT Data v | as | CSV ~
v @ Deployment #1
B notes # Date & None Depth Submerged ~ | @ | ftH20 ~ ||} Temperature. °C ~ | [}
@ vanual Entry 1 8/5 0.61272 24.352
2 8/5 -0.61630 24.359
Auto-B: Auto-Baro
R 3 8/5 -0.61272 24350
4 /5 061272 24359
5 8/5 Baro Value: 100KPa -0.61630 24.359
6 8/5 Other bar-Log's | -0.61630 24.359
7 8/5 | -0.61630 24.367
8 8/5 Enter Value | -0.61272 24.367
9 8/5 -0.61630 24.367
10 8/5/2025 2:46:11pm -0.61630 24.367
11 8/5/2025 2:46:13pm -0.61630 24.375
12 8/5/2025 2:46:15pm -0.61630 24.375
& software Settings 13 R/R/2N78 7-4A1Tnm NA1777 74378
@) CONNECT VIEW ALL
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More Tools

Additional tools are available to manipulate your data. They can help account for elevation and/or
density differences and correct for mistakes made during setup or deployment.

Sort By: Date Modified + ~ Q

Overview

Resources

24.400
v @ connected

# dipper-Log 128+: B31413
# barlog 64: A15761

(7] Help

24350
I catalog

Temperature ("C)

Projects

Depth Submerged (ftH20)

© Add New Project
> A Timbe
s & Example Project
@ Add Deployment
> @ Heron Water Well

24300

o

* Software Settings

) CONNECT

-0.6100

-0.6150

-0.6200

SELECT DATA RANGE

8/5/2025 2:46:00pm
Baro Value: 100KPa ~

# Date & Time
v 9 Deployment #1 1 8/5/2025 2:45:53pm
B notes 2 8/5/2025 2:45:55pm
B Manual Entry 3 8/5/2025 2:45:57pm
= AutoBaro 4 8/5/2025 2:45:59pm
5 8/5/2025 2:46:01pm
6 8/5/2025 2.46:03pm
7 8/5/2025 2:46:05pm
8 8/5/2025 2:46:07pm
9 8/5/2025 2:46:09pm

8/5/2025 2:46:11pm
8/5/2025 2:46:13nm

Realtime

Settings

Deployment #1 dipper-Log 128+ plot

8/5/2025 2.45:00

MORE TOOLS

Depth Submerged ~

Q
0.61272
0.61630
0.61272
0.61272
-0.61630
0.61630
-0.61630
0.61272
-0.61630
0.61630
-0.61630

8/5/2025 2:50:00pm

8/5/2025
Data ~

ftH20 ~ . Temperature

24,352
24.359
24,359
24.359
24,359
24.359
24.367
24.367
24.367
24.367
24375

2:52:00pm

as | CSV ~

DC'.

VIEW ALL

Click on the MORE TOOLS button. You have the option to:

e Qverride the default time settings
e Apply drift compensation

e Average your readings
o Apply a pressure offset

e Apply a pressure multiplier
e Adjust Distance to Datum and Total Depth values

e Override the default decimal place setting

e Adjust data to match manual entry from a water level meter

Override the Default Time Settings

Check the Override Default Time Settings box and select your time settings from the dropdown

menus.
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Drift Compensation

To apply drift compensation, check the Drift Compensation box. See the Drift Compensation
section for more details on configuring this tool.

More Tools

[C] Override Default Time Settings

@ Drift Compensation

[] Averageevery | 5 readings
erage reading timestamp

Pressure Offset

None

Pressure Multiplier

None

Backup Barometric Value: 32.24123ftH20

CANCEL  UPDATE
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Averaging the Readings

Check the box next to “Average every __readings.” This feature will average a group of readings
into one data point. The new data point will assume the time stamp of the first reading, last
reading or average timestamp of the group.

For example, if “Average every 5 readings, use first reading timestamp” was inputted, it would
average every 5 readings into one (500 readings would become 100 readings) and each reading
would assume the timestamp of the first reading in each group.

More Tools

[[] Override Default Time Settings

(EDT -4:00

[ Drift Compensation

[] Averageevery | 5 readings

erage reading timestamp

Pressure Offset

None

Pressure Multiplier

None

Backup Barometric Value: 32.24123ftH20

CANCEL  UPDATE
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Applying a Pressure Offset

To apply a constant shift to your pressure data set there are 4 options to choose from:

e By First Reading: Uses the first pressure reading of the mission as the constant
barometric pressure value. Use when no bar-Log data is available and your dipperLog
started logging before placement in the well.

e By Last Reading: Uses the last pressure reading of the mission as the constant
barometric pressure value. Use when no bar-Log data is available and your dipperLog
started logging when already submerged in the well.

e By Programmed Value: Uses the back-up barometric pressure value from zeroing the
logger.

e By Custom Value: Shifts the pressure values by a manually entered value.

More Tools

Use | First reading timestamp

None

‘— Pressure Offset

None

By First Reading

By Last Reading

By Programmed Value

By Custom Value

| isranceTonamm

CANCEL UPDATE
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Applying a Pressure Multiplier

To apply a constant scaling factor to the pressure dataset, there are 2 options to choose from:

e Low Level: Multiplies the pressure values by 0.9.

e Custom Multiple: Multiplies the pressure values by a manually entered value. Use
this option when the liquid you are monitoring has a density that is not equal to 1
(e.g. seawater or brackish water).

More Tools

Use | First reading timestamp

Pressure Offset

None

None

‘— Pressure Multiplier

None
Low Level

Custom Multiple

[FA ) TLETanT

CANCEL UPDATE

Adjust Distance to Datum and Total Depth values

Allows you to update the Distance to Datum and Total Depth values, if they differ from the
values inputted during device setup.
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Override Default Decimal Places

The default number of decimal places displayed is 3. To override this value, check the Override
Decimal Places box for the desired parameter and input a number.

More Tools
Backup Barometric Value: 32.24123ftH20

< Distance to Water
Distance to Datum

0 ft «

. Depth
Submerged

Total Depth (optional) <— Depth of Water

0 ft -

—— N—

Override Decimal Places for Pressure
4
Override Decimal Places for Temperature

4

(] Adjust to match water level meter

CANCEL  UPDATE
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Adjusting to Match a Water Level Meter

To adjust your dataset to match data that was collected using a Heron water level meter, check
the Adjust to match water level meter box. This will pull data that was manually added to the
Manual Entry section under the deployment. For more details on how to enter the data and the
adjustments made, please see the Manual Entry chapter of this manual.

. sHpmergEd «+— Depth of Water
Total Depth (optional) i
0 ft -
—

[ override Decimal Places for Pressure

More Tools

[ oOverride Decimal Places for Temperature

Adjust to match water level meter

# Date & Time Distance to Water v = @ | ft v || Temperature| °C ~

8/6/2025 12:32:00pm 0.0197 15.000
8/6/2025 12:33:00pm 0.0164

CANCEL  UPDATE

Once all desired tools have been employed, click UPDATE and your data will be adjusted. To modify your
applied tools or revert to your original dataset, click the MORE TOOLS button and make your
changes/deselect the boxes.
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Exporting the Data

From the Data tab, you can export your data in the form of a table or a graph.

Exporting a Table

From the dropdown beside the EXPORT button, select Data and then select the file type. Any data
filters, adjustments, etc. will be reflected in the exported data. Click EXPORT to finish.

To modify the default export settings, see the Advanced Settings section of the Changing the Default
Settings chapter.

Resources Deployment #1 dipper-Log 128+ plot
24.400 -0.4900
v @ Connected
# dipper-Log 128+ B31413
# bar-Log 64: A15761 =
@ Hep 5 %
R Catalog E' 3
£ 24350 3 -0.4950
Projects E E
© Add New Project = f}
> M Timbe =
w M Example Project
© Add Deployment 24300 -0.5000
> Q Heron Water well 8/5/2025 2-46-00pm 81512025 2-43-00pm 81512025 250 00pm 8/5/2025 7-57.000m
~ 9 Depluymem #1 SELECT DATA RANGE Auto-Baro - MORE TOOLS S
Not
s # Date & Time Depth Submerged ~ | @ | ftH20 ~ . Temperature . °C | csv
B Vanual Entry 1 8/5/2025 2:45:53pm -0.49228 24352 ey
= Auto-Baro 2 8/5/2025 2:45:55pm -0.49586 24.359
3 8/5/2025 2:45:57pm 0.49228 24.359 T
4 8/5/2025 2:45:59pm -0.49228 24.359
5 8/5/2025 2:46:01pm -0.49586 24.359
6 8/5/2025 2:46:03pm -0.49586 24.359
7 8/5/2025 2:46:05pm -0.49586 24.367
8 8/5/2025 2:46:07pm -0.49228 24.367
9 8/5/2025 2:46:09pm -0.49586 24.367
10 8/5/2025 2:46:11pm -0.49586 24.367
11 8/5/2025 2:46:13pm -0.49586 24.375
12 8/5/2025 2:46:15pm -0.49586 24.375
22 software Settings 13 8/5/2025 2:46:17pm 0.49228 24.375
) CONNECT VIEW ALL
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Exporting a Graph

From the dropdown beside the EXPORT button, select Graph and then select the file type. The exported

graph will reflect exactly what is shown on the Heron Instruments software — including any filters,

adjustments, etc. applied to the graph. Click EXPORT to finish.

Resources

v ¥ Connected

/' dipper-Log 128+ B31413

# bar-Log 64: A15761

(7] Help
M Catalog

Projects

@ Add New Project

> # Timbe

~ & Example Project
© Add Deployment

> @ Heron water well

~ 9 Deployment #1
B notes
B Manual Entry
= Auto-Baro

dipper-Log 128+: B31413

* Software Settings

) CONNECT

24.400

24350

Temperature [°C)

24300

SELECT DATA RANGE

#

0 oW W R =

Depth Submerged (ftH2 0)

-0.4300

-0.4950

-0.5000

Realtime

Settings

8/5/2025 2:46:00pm

Auto-Baro ~

Date & Time

8/5/2025 2:45:53pm
8/5/2025 2:45:55pm
8/5/2025 2:45:57pm
8/5/2025 2:45:59pm
8/5/2025 2:46:01pm
8/5/2025 2:46:03pm
8/5/2025 2:46:05pm
8/5/2025 2:46:07pm
8/5/2025 2:46:09pm
8/5/2025 2:46:11pm
8/5/2025 2:46:13pm

OIE/NNIE N AL Ermmn

8/5/2025 2:48:00pm
MORE TOOLS

Depth Submerged «

-0.49228
-0.49586
-0.49228
-0.49228
-0.49586
-0.49586
-0.49586
-0.49228
-0.49586
-0.49586
-0.49586

N ANEOA

Deployment #1 dipper-Log 128+ plot

]

8/5/2025 2:50:00pm

= |-

ftH20 ~ . Temperature  “

24.352
24.359
24.359
24.359
24.359
24.359
24.367
24.367
24.367
24.367
24.375

nA2TE

8/5/2025 2:52.00pm

PNG =
PNG |

PDF
JPG

VIEW ALL
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Realtime Readings

Realtime readings can be accessed in the Realtime tab for connected devices. Realtime readings will
immediately begin to populate the table and graph every 1 second.

This tab functions similarly to the Data tab. Details on how to modify the graph, changing

parameters/units and using the MORE TOOLS options can be found under the Viewing and Refining the
Data chapter.

Note: To calculate the Depth Submerged in the Realtime readings the back-up/programmed value from
zeroing the logger is used as the barometric pressure. For more details see the Pressure Loggers and
Barometric Pressure Compensation sections.

Sort By: Date Modified v = Q Overview Data Settings
Resources Deployment #1 dipper-Log 128+ plot
23.840 32 8920
~ ¥ Cconnected
' dipper-Log 128+: B31413
# bar-Log 64: A15761 5
& S 328900
@ Help = =
I catalog £ 23830 §
Projects = T 328880
@ Add New Project .
> M Timbe
~ M Example Project 23.820 32.8860
© Add Deployment 8/6/2025 2:24:00pm
> Q@ Heron Water Well 1 Seconds - MORE TOOLS sToP SAVE [ Save to database when done
v @ Deployment #1
otes
B Manual Entry # Date & Time Total Pressure « 0 ftH20 ~ . Temperature | °C « .
= Auto-Baro 1 8/6/2025 2:23:58pm 32.88648 23.820
dipper-Log 128+ B31413 2 8/6/2025 2:23:59pm 32.89007 23.828
3 8/6/2025 2:24:00pm 32.88648 23.828
4 8/6/2025 2:24:01pm 32.88648 23.828
5 8/6/2025 2:24:02pm 32.88648 23.836
¢ Software Settings
f:) CONNECT VIEW ALL
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Changing the Reading Interval and Pausing the Readings

The reading interval can be changed by entering a new value and selecting the time unit from the
dropdown list on the Realtime tab.

Pause the real-time readings from populating by pressing the STOP button. Start the readings again by
clicking the START button.

Sort By: Date Modified + + Q Overview Data Realtime Settings

Resources Deployment #1 dipper-Log 128+ plot
23840 32.8920

~ @ Cconnected

/' dipper-Log 128+ B31413

# bar-Log 64: A15761

@ Help
W catalog

328900

23830

Temperature [°C)

Projects 32.8880

Total Pressure (ftH20)

@ Add New Project
> M Timbe

v M Example Project 23820 32.8860
5 o1
© Add Deployment /6/2025 2-24:00pm

> @ Heron Water Well 5 MORE TOOLS STOP SAVE [ Save to database when done

~ @ Deployment #1 Seconds ndicator
E Notes

B Manual Entry # Minutes el Total Pressure 0 ftH20 ~ . Temperature | °C = .
= Auto-Baro u - & 5 2:23:58pm 32.88648 23.820
2 8/6/2025 2:23:59pm 32.88007 23.828
: 3 8/6/2025 2:24:00pm 32.88648 23.828
4 8/6/2025 2:24:01pm 32.88648 23.828
5 8/6/2025 2:24:02pm 32.88648 23.836
6 8/6/2025 2:24:03pm 32.88648 23.836
7 8/6/2025 2:24:04pm 32.88648 23.836
8 8/6/2025 2:24:05pm 32.88648 23.828
Q Software Settings 9 8/6/2025 2:24:06pm 32.88648 23.836
) CONNECT VIEW ALL

Auto-Scrolling

In Realtime view, new readings will add to the bottom of the table. The software will automatically
scroll, so you are always able to see the new datapoint populated at the bottom.

If you scroll away from the bottom of the table, the auto-scrolling will pause allowing you to look at
specific rows of the table without shifting. To resume the auto-scrolling, scroll to the very bottom of the
table.
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The Rise/Fall Indicator

The Indicator tab provides a rolling/moving average of a single parameter and indicates whether the
readings are increasing or decreasing.

To use the Indicator feature, ensure you only have one parameter selected on the Chart tab.

Sort By: Date Modified ¥ ~ Q overview Data settings

Resources Deployment #1 dipper-Log 128+ plot
24250

v ‘ Connected
# dipperLog 128+: B31413
# barLog 64: A15761

@ Help

24200
W Catalog

Temperature (°C)

Projects

© Add New Project

~ M Example Project 24150
° Add Deployment 8/7/2025 12:04:00pm 8/7/2025 12:05:00pm 8/7/2025 12:06:00pm

> @ Heron water Well 5 Seconds ¥ MORE TOOLS | | START SAVE [[] save to database when done

v @ Deployment #1
B notes Indicator
B Manual Entry # Date & Time O - - Temperature| °C ~ | [l

f’ Auto-Baro 1 0, UZ3 TZU3.33pm 4,193
S ) G 2 8/7/2025 12:03:36pm 24.195

3 8/7/2025 12:03:37pm 24.203

4 8/7/2025 12:03:38pm 24.195
> & Example Project #2 5 8/7/2025 12:03:39pm 24.203

6 8/7/2025 12:03:40pm 24.203

7 8/7/2025 12:03:41pm 24211

X software Settings 8 8/7/2025 12:03:42pm 24.203

) CONNECT VIEW ALL

Click on the Indicator tab. To adjust the number of readings used in the rolling average, click the
dropdown field to the right of Rise and Fall Indications and make your selection. The rolling average will
update every time a new reading is populated. If “5 Reading Average” is selected, this means that the
average is calculated using the five most recent data points.

Sort By: Date Modified + ~ Q Overview Data Settings

Resources Deployment #1 dipper-Log 128+ plot
24300

~ ¥ Connected

# dipperLog 128+: B31413

[5)
#' barLog 64: A15761 = 24250
s
@ Help §
I catalog £ 24200
&
Projects
24150
© Add New Project 772025 12:04:00pm 8/7/2025 12:09:00pm 8772025 12:14:00pm
v & Example Project 5 Seconds ~ MORE TOOLS | | START SAVE [J Save to database when done
© Add Deployment
> Q@ Heron Water Well Chart | Indicator
v @ Deployment #1
Rise and Fall Indications| 5 Reading Average =
B notes
VN
B Manual Entry None

= Auto-Baro

. 1 Reading Average o
& bar-Log 64: A15761
dipper-Log 128+: B31413 Seadinafiverage
> A Example Project #2 10 Reading Average B

15 Reading Average

* Software Settings

(Settings for Graph are controlled by the "Chart” tab)

(:) CONNECT VIEW ALL
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The rolling average will be displayed in Red, Green or Black text with an indication arrow. Red indicates
that the reading values are falling, green indicates that they are rising and black indicates no change.

Rise and Fall Indications | 5 Reading Average ~

A

| 24.244 °C

(Settings for Graph are controlled by the "Chart” tab)

VIEW ALL

Saving Realtime Data

There are two ways to save real-time readings to the Data tab: the SAVE button or the Save to database
when done checkbox.

Sort By: Date Modified + v Q Overview Data Settings

Resources Deployment #1 dipper-Log 128+ plot
23900 328850

~ @ Cconnected
/' dipper-Log 128+ B31413
# bar-Log 64: A15761

© Help
W catalog

23880

328800

Temperature (°C)

Projects 23.860

Total Pressure (ftH2 Q)

@ Add New Project
> A Timbe
~ A Example Project 23.840 32.8750
© Add Deployment
> @ Heron Water Well 1 Seconds ~ || MORETOOLS | | START ||:| Save to database when done I

~ @ Deployment #1
Indicator
ﬁ Notes

8/6/2025 3:01:00pm 8/6/2025 3:02-:00pm 8/6/2025 3:03:00pm

B Manual Entry # Date & Time Total Pressure ~ 0 ftH20 ~ . Temperature | °C = .

= Auto-Baro 1 8/6/2025 3:00:03pm 32.88290 23.859

" 2 8/6/2025 3:00:04pm 32.88290 23.875
[INEEEED 5 eemsseosm  mess mas

4 8/6/2025 3:00:06pm 32.87931 23.875

5 8/6/2025 3:00:07pm 32.88290 23.883

6 8/6/2025 3:00:08pm 32.87931 23.875

7 8/6/2025 3:00:09pm 32.87931 23.875

8 8/6/2025 3:00:10pm 32.87931 23.883

# Software Settings 9 8/6/2025 3:00:11pm 32.87931 23.883
(:) CONNECT VIEW ALL
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The SAVE button can be clicked at any time, and the real-time data will be immediately added to the
Data tab. If there is currently data open in the Data tab, the real-time readings will be added to the end
of the table (as they have the most recent timestamps). You will be given the option to view the saved
data in the Data tab or return to Realtime view.

Note: if you select VIEW SAVED DATA, the Realtime tab will reset — all previous data and settings will be
cleared. This will happen any time you click away from the Realtime tab.

Saved

Your Data is now saved in the Data Tab

VIEW SAVED DATA RETURN TO REALTIME VIEW

When the Save to database when done box is checked, if you try to exit the Realtime tab a window will
appear giving you the option to save your data or return to Realtime view. The SAVE DATA button
functions the same way as the SAVE button and your data will be added to the Data tab. Clicking
RETURN TO REALTIME VIEW will keep you on the Realtime tab and the Save to database when done box
will still be checked. This feature is very useful in reminding you to save your data before exiting the
Realtime tab.

Confirm

Are you ready to save your data?

RETURN TO REALTIME VIEW  SAVE DATA

Note: Saving data from Realtime view is considered a “Download” and each save has a “Download
Date”. Therefore, in the Data tab you can filter Realtime data based on when you saved it. For more
details on how to filter by download date, see the Filtering the Data Range section.
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Data Management

Data management is handled by a database that can be imported or exported as required. The data
management panel is used to navigate the database. It has two main sections: Resources and Projects.

SortBy: Name ™ ~ Q Overview Data Realtime Settings

Resources # DOWNLOAD ~ H STOP () CLEAR & REMOVE DEVICE FROM PROJECT

v ¥ Connected

. Device Information
# dipper-Log 128+: B31413

# barLog 64: A15761 Device: dipper-Log 128+
@ Hep Serial #: B31413
I catalog Range: 32.8ftH20

Max Data Sets: 128,000
Projects

© Add New Project Battery Lifespan: 100%

v A Example Project Memory Usage: 0%
© Add Deployment Total Readings: 194 / 128,000
> @ Heron Water Well Status: Not on a mission
~ @ Deployment #1 Last Mission Started: 8/5/2025 at 2:45pm
B notes

Current Pressure: 32.86856ftH20

B Manual Entry Current Temperature: 21.727C

=2 Auto-Baro

REFRESH MEASUREMENTS
dipper-Log 128+: B31413

> A Example Project #2
DRIFT COMPENSATION UTILITY ZERO LOGGER

¢ Software Settings

w’:) CONNECT VIEW ALL

Resources

In Resources, all your connected devices will be displayed under Connected. Help will bring you to a page
with troubleshooting tips, this manual, and a contact page if you need further assistance. Catalog will
display the most recent version of Heron Instruments’ catalog.

Sort By: Date Modified + v Q Overview Data

Resources ¥ DOWNLOAD @~ B STOP | | (x) CLEAR{

~ @ Connected

. Device Information
# dipper-Log 128+ B31413

/' bar-Log 64: A15761 Device: dipper-Log 128+
@ Hep Serial #:2B31413
R0 Catalog Range: 32.8ftH20
Max Data Sets: 128,000
Projects

© Add New Project Battery Lifespan: 100%

46



HERO

INSTRUMENTS INC.

Projects Overview

The Projects section is where all projects and their deployments are organized. Expand and collapse
projects and deployments using the dropdown arrows.

Projects

© Add New Project
~v & Example Project
@ 2dd Deployment
> @ Heron Water Well
v @ Deployment #1
E Notes
. Manual Entry
= Auto-Baro

dipper-Log 128+: B31413

> M Example Project #2

Battery Lifespan: 100%

Memory Usage: 0%

Total Readings: 194 / 128,000
Status: Not on a mission
Last Mission Started: 8/5/2025 at 2:45pm

Current Pressure: 32.86497ftH20
Current Temperature: 21.961C

REFRESH MEASUREMENTS

DRIFT COMPENSATION UTILITY ZERO LOGGER

Under deployments, the devices used will be listed. Connected devices will have a green logger icon,
while disconnected devices will have a black logger icon.

Sort By: Date Modified ¥+ ~ Q

Resources

~v @ Connected

# barlog 64: A15761

# dipper-Log 128+ B31413
@ Help
I catalog

Projects

© Add New Project
~ A Example Project
© Add Deployment
w 9 Heron Water Well
B Notes
. Manual Entry
=2 Auto-Baro
- # dipper-Log Vented+: B50603
v 9 Deployment #1
B Notes
. Manual Entry
=2 Auto-Baro

dipper-Log 128+: B31413

* Software Settings

) CONNECT

Overview Data

Realtime

Settings

# DOWNLOAD | ~ m STOP (®) CLEAR & REMOVE DEVICE FROM PROJECT

Device Information

Device: dipper-Log 128+
Serial #:B31413

Range: 32.8ftH20

Max Data Sets: 128,000

Battery Lifespan: 100%

Memory Usage: 0%

Memory will be full: 10/19/2054
Total Readings: 1 /128,000
Current Mission Started: 8/5/2025 at 2:31pm

Current Pressure: 32.843461tH20
Current Temperature: 24.367C

REFRESH MEASUREMENTS

DRIFT COMPENSATION UTILITY ZERO LOGGER

VIEW ALL
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If a logger has been used in multiple projects, it may appear multiple times in the Projects section. When
connected, the current project the device is assigned to will have the green logger icon, while older
projects will have the black logger icon. This means that even though the device is connected, it is no
longer assigned to that project.

Projects
© Add New Project Battery Lifespan: 100%
v & Fanshaw Project Memory Usage: 1%

© Add Deployment Memory will be full: 2021-09-16

v @ Preliminary Test Well Total Readings: 565 / 64,000

Current Mission Started: 2021-09-15 at 10:57am

s~ & Darling Property
Current Pressure: 9.993mH20

Current Temperature: 25.125C

@ Add Deployment
> @ Darling well 1
~ 9 Darling Well 2 REFRESH MEASUREMENTS
# dipper-Log 64: B31326

> M McMaster Landfill

DRIFT COMPENSATION UTILITY ZERO LOGGER

Search for projects, deployments and devices using the search feature at the top of the Data
Management Panel.

Sort By: Name * ~ | Q | Data Realtime Settings

Resources # DOWNLOAD ~ H STOP (®) CLEAR & REMOVE DEVICE FROM PROJECT

w ¥ Connected

. Device Information
# dipper-Log 128+: B31413

# barlog 64: A15761 Device: dipper-Log 128+
@ Help Serial #:B31413
] Catalog Range: 32.8ftH20
Max Data Sets: 128,000

Projects

© Add New Froject Battery Lifespan: 100%

~ & Example Project Memory Usage: 0%

© ~dd Deployment Total Readings: 1/ 128,000

> @ Heron Water Well Status: Not on a mission

~ @ Deployment #1 Last Mission Started: 8/7/2025 at 9:14am
B notes

Current Pressure: 32.86497ftH20

B Vanual Entry Current Temperature: 22.727C
=2 Auto-Baro

REFRESH MEASUREMENTS
dipper-Log 128+: B31413

> A Example Project #2
DRIFT COMPENSATION UTILITY | | ZERO LOGGER

* Software Settings

(:) CONNECT VIEW ALL
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|B| X

Overview Data

Realtime Settings

, bar-Log 64: A15761
o Example Project #2
Deployment #1

# DOWNLOAD ~ H STOP

. dipper-Log 128+: B31413
o Example Project
Deployment #1
, dipper-Log Vented+: B50603

# Example Project
Heron Water Well

Device Information

Device: dipper-Log 128+
Serial #:B31413

Range: 32.8ftH20

Max Data Sets: 128,000

Battery Lifespan: 100%
Memory Usage: 0%

Total Readings: 1 /128,000
Status: Not on a mission

Current Pressure: 32.86497ftH20
Current Temperature: 22.727C

REFRESH MEASUREMENTS

DRIFT COMPENSATION UTILITY

¢ CONNECT

(®) CLEAR & REMOVE DEVICE FROM PROJECT

Last Mission Started: 8/7/2025 at 9:14am

ZERO LOGGER

VIEW ALL

Organizing the Projects

On the Data Management panel use the Add New Project button to create new projects. Within the
projects, use the Add Deployment button to create new deployments. Note: Devices will not yet appear
under newly created sections until they are assigned in device setup.

Projects

@ Add New Project

~ & Example Project
I © Add Deployment I
» @ Heron Water Well
v @ Deployment #1
E Notes
. Manual Entry
= Auto-Baro

dipper-Log 128+: B31413

> M Example Project #2

Battery Lifespan: 100%

Memory Usage: 0%

Total Readings: 194/ 128,000
Status: Not on a mission
Last Mission Started: 8/5/2025 at 2:45pm

Current Pressure: 32.86497ftH20
Current Temperature: 21.961C

REFRESH MEASUREMENTS

DRIFT COMPENSATION UTILITY ZERO LOGGER
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Right-click on any project or deployment to rename, export or delete it. More information regarding
importing and exporting can be found in the Importing and Exporting the Database section. For
deployments, when you right-click there is also a Move to option. This allows you to move a deployment
to a different project by selecting an existing project from the dropdown list.

Projects

Battery Lifespan: 100%
0 Add New Project

~ M Example Project Memory Usage: 0%

Total Readings: 194 / 128,000
wel Status: Not on a mission
B Last Mission Started: 8/5/2025 at 2:45pm

Rename Project
Export Project
Delete Project

Current Pressure: 32.864971tH20
Current Temperature: 21.961C

e R
= Auto-Baro

: REFRESH MEASUREMENTS
dipper-Log 128+: B31413

> M Example Project #2
DRIFT COMPENSATION UTILITY | | ZERO LOGGER

Move Deployment #1 X

This will move the deployment and associated devices
to the project you choose.

Example Project

Example Project

Example Project #2
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Sort your projects in the data management panel by Name or by Date Modified using the dropdown
menu in the top left-hand corner of the screen. Note that this does not sort the order of deployments

within the project — they remain in the order that they were added.

ﬂ Heren Instruments

Sort By: Name ™ «

R¢ Date Modified
w~ Date Modified
Name

Name

I catalog

Projects

© AddNew Project
~ M Example Project

@ Add Deployment

> @ Deployment #1
w M Example Project #2

@ Add Deployment

> Q Deployment #1

> @ Heron Water well

* Software Settings

() CONNECT

Overview Data

Realtime

Settings

% DOWNLOAD @~ m STOP (®) CLEAR & REMOVE DEVICE FROM PROJECT

Device Information

Device: dipper-Log 128+
Serial #:B31413

Range: 32.8ftH20

Max Data Sets: 128,000

Battery Lifespan: 100%

Memaory Usage: 0%

Total Readings: 1 /128,000
Status: Not on a mission
Last Mission Started: 8/7/2025 at 9:14am

Current Pressure: 32.864971tH20
Current Temperature: 22.727C

REFRESH MEASUREMENTS

DRIFT COMPENSATION UTILITY ZER

VIEW ALL
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Notes Tab

Within each deployment there is a Notes bar. After clicking on Notes, you will be brought to the Notes
tab. It has two sections: Deployment Notes and Deployment Attachments. The main space under
Deployment Notes is a text box to jot down your notes.

Sort By: Date Modified ¥ v Q

Resources

Deployment Notes Deployment Attachments
~ . Connected
# dipper-Log 128+ B31413 Test Note #1 No attachments yet!
' barlLog 64: A15761 Select or upload a file
- Welcome to the Notes tab
Q Help
W] catalog
Projects

° Add New Project
~ & Example Project
@ Add Deployment
> @ Heron Water well
v Q Deployment #1
B Notes
. Manual Entry
=3 Auto-Baro
' dipper-Log 128+ B31413
> ¥ Example Project #2

Drop a file to upload

UPLOAD FILE
a Software Settings

¢y CONNECT VIEW ALL

The Deployment Attachments section allows you to upload files and store them within a deployment for
easy access.

Sort By: Date Modified v v Q,

Resources

Deployment Notes Deployment Attachments
v @ Connected
v dipper-Log 128+: B31413 Test Note #1 No attachments yet!
rd bar-Log 64: A15761 Select or upload a file
- Welcome to the Notes [tab!
@ Help
M catalog
Projects

o Add New Project
v A Example Project
@ Add Deployment
> @ Heron water well
v @ Deployment #1
. Manual Entry
=2 Auto-Baro
/' dipper-Log 128+ B31413
> A Example Project #2

Drop a file to upload

UPLOAD FILE

0 Software Settings

¢y CONNECT VIEW ALL
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Uploading a File

To upload a file, click the UPLOAD FILE button and select the file from your computer or drop a file into
the gray region. Note: You can select/drop multiple files at once.

Sort By: Date Modified ¢+ v Q

Resources Deployment Notes Deployment Attachments

~v @ connected

# dipper-Log 128+ B31413 Test Note #1 No attachments yet!
# bar-log 64: A15761 Select or upload a file
- Welcome to the Notes tab!
@ Help
I catalog
Projects

© Add New Project
s~ & Example Project
© Add Deployment
% @ Heron Water well
v @ Deployment #1
. Manual Entry
== Auto-Baro
# dipper-Log 128+ B31413
> & Example Project #2

Drop a file to upload

UPLOAD FILE
* Software Settings

f:) CONNECT VIEW ALL

Once the file has been uploaded, you will receive a “Success” message, and your file will be listed in the
gray region.

Sort By: Date Modified + v Q

Resources Deployment Notes Deployment Attachments

~ @ Connected

# dipper-Log 128+ B31413 Test Note #1 Y Excel_Test_File.xls
# bar-Log 64: A15761 K Select or upload a file
- Welcome to the Notes tab!
@ Help B word_Test_File.do
W catalog X
Projects

@ Add New Project
~ A Example Project
@ Add Deployment
> @ Heron Water well
v @ Deployment #1
. Manual Entry
= Auto-Baro
# dipperLog 128+ B31413
> M Example Project #2

Drop a file to upload

UPLOAD FILE

* Software Settings

f:) CONNECT VIEW ALL
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Viewing a File

Select the file and click on the VIEW button. This will export the file and open it using the appropriate
app on your computer. Note: If you edit the file, the changes will not be stored in the Heron Instruments
software, and the file will need to be reuploaded.

Sort By: Date Modified ¥+ ~ Q

Resources Deployment Notes Deployment Attachments
~ @ connected

# dipper-Log 128+ B31413 Test Note #1 B Excel_Test File.xls
# bar-Log 64: A15761 x Excel_Test_File.xlsx
- Welcome to the Notes tab!
© Help Word_Test_File.do

. RENAME
Projects

© Add New Praject EXPORT

~ & Example Project
@ Add Deployment
3> Q@ Heron Water Well

DELETE

v Q Deployment #1

. Manual Entry

= Auto-Baro

# dipper-Log 128+ B31413
> M Example Project #2

Drap a file to upload

UPLOAD FILE
¢ Software Settings

w':) CONNECT VIEW ALL

Renaming, Exporting and Deleting a File

Rename, export or delete a file by selecting it and clicking the applicable button.

Deployment Notes Deployment Attachments

Test Note #1 ‘ Excel_Test_File.xls

X Excel_Test_File.xlsx
- Welcome to the Notes tab!
‘ Word_Test_File.do

cx VIEW

RENAME

EXPORT

DELETE
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Importing and Exporting the Database

Exporting Projects and Deployments

In the data management panel, right-click on the project/deployment and click Export

Project/Deployment. Name the file and save it to your computer.

Sort By: Date Modified + ~ Q T Data

v @ Connected

. Device Information
# dipper-Log 128+: B31413

#" bar-Log 64: A15761 Device: dipper-Log 128+
@ Help Serial #:B31413
K] Catalog Range: 32.8ftH20
Max Data Sets: 128,000
Projects

© Add New Project Battery Lifespan: 100%

~ M Example Project Memory Usage: 0%
Rename Project Total Readings: 1/ 128,000
well Status: Not on a mission

I Export Project I“ Last Mission Started: 8/7/2025 at 9:14am

Delete Project #2
Current Pressure: 32.84346ftH20

Current Temperature: 23.594C

Resources # DOWNLOAD | + H STOP (®) CLEAR & REMOVE DEVI

Exporting the Entire Database

Click on Software Settings in the bottom left-hand corner of the screen. Click on the Advanced tab and
beside Export Database click on the CHOOSE LOCATION button. Name the file and save it to your

computer.

Sort By: Date Modified + v Q

Version 8.1.39

Resources Software Settings

~ @ Connected

# dipperLog 128+ B31413 Export Database

# bar-Log 64: A15761 Import and Merge Database | SELECT FILE
@ Help
M0 catalog Pressure Column Default Raw Device Pressure =
Projects

Data Export Options All Column Options (Default) «

© Add New Project
> A Example Project Exported Date and Time  \jerged (Default)

> 1 Example Project #2
Filename Format Example Filename "123456_2025-08-07_1038am_data"

Logger Serial Number ~
Date of file creation +

Type of data (Data/Graph) «

ADD ITEM

Tools RESTORE EXAMPLE PROJECT DRIVER INSTALLATION

) CONNECT

VIEW ALL
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Importing Heron Database Files

In Software Settings, go to the Advanced tab. Beside Import and Merge Database, click on the SELECT
FILE button. Choose your Heron Database file and it will be uploaded to the software. Once completed
you will receive an “Import Complete” message, and your imported project/deployment will be visible in
the data management panel.

Sort By: Date Modified ¥ -

Q

Resources

~ # Connected
# dipperLog 128+ B31413
# bar-Log 64: A15761

© Add New Project
~ # Example Project #2
@ Add Deployment
> @ Deployment #1
> # Example Project

) CONNECT

TR ‘ Version 8.1.39

Basic

Software Settings

Export Database | CHOOSE LOCATION

Import and Merge Database

@ Hep
I catalog Pressure Column Default Raw Device Pressure =
Projects Data Export Options  All Column Options (Default) =

Exported Date and Time  \jerged (Default) +

Filename Format Example Filename "123456_2025-08-07_1038am_data"

Logger Serial Number «
Date of file creation -

Type of data (Data/Graph) «

ADD ITEM

Tools RESTORE EXAMFPLE PROJECT DRIVER INSTALLATION

VIEW ALL

T
\| @ Import Complete

Filename Format Example Filename "123456_2025-08-07_1038am_data"

Logger Serial Number «

Date of file creation v

Type of data (Data/Graph) +
ADD ITEM
DRIVER INSTALLATION

Tools | RESTORE EXAMPLE PROJECT
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Stopping a Mission and Clearing a Logger

Between missions, it is important to stop and clear the logger to conserve battery especially if storing for
extended periods of time. This is also required if you would like to assign a logger to a different project.

Stopping a Mission

On the Overview tab of the device, click the STOP button. A confirmation window will appear, click STOP
LOGGER.

Sort By: Date Modified + ~ Q

Overview Data Realtime Settings
Resources ¥ DOWNLOAD | W STOP | @ CLEAR & REMOVE DEVICE FROM PROJECT

~ ¥ Cconnected

. Device Information
# dipper-Log 128+: B31413

#" barLog 64: A15761 Device: dipper-Log 128+
@ Help Serial #:B31413
A Catalog Range: 32.8ftH20
Max Data Sets: 128,000

Projects

© Add New Project Battery Lifespan: 100%

~ # Example Project Memory Usage: 0%

© Add Deployment Memory will be full: 2/1/2026

> @ Heron Water Well Total Readings: 1/ 128,000

~ @ Deployment #1 Current Mission Started: 8/7/2025 at 11:04am
B Notes
5 Current Pressure: 32.84346ftH20

RanLel ALY Current Temperature: 23.859C

= Auto-Baro

REFRESH MEASUREMENTS
dipper-Log 128+: B31413

> # Example Project #2
DRIFT COMPENSATION UTILITY ZERO LOGGER

* Software Settings

(:) CONNECT VIEW ALL
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Clearing a Logger

Before clearing a logger, ensure you have downloaded the data to the software. Data stored on the
logger cannot be recovered after clearing.

Click the CLEAR & REMOVE DEVICE FROM PROJECT button. A confirmation window will pop up. Click on
CLEAR & REMOVE FROM PROJECT.

Sort By: Date Modified ¥ ~  Q Data Realtime Settings

Resources & DOWNLOAD ~ | m STOP | (® CLEAR & REMOVE DEVICE FROM PROJECT
~ @ Cconnected
# dipper-Log 128+ B31413
# bar-Log 64: A15761 Device: dipper-Log 128+
@ Help Serial #: B31413
Range: 32.8ftH20
Max Data Sets: 128,000

Device Information

I catalog

Projects

© Add New Praject Battery Lifespan: 100%

~ & Example Project Memory Usage: 0%

© Add Deployment Total Readings: 1/ 128,000

> @ Heron Water Well Status: Not on a mission

~ @ Deployment #1 Last Mission Started: 8/7/2025 at 11:04am
E Notes
S Current Pressure: 32.84346tH20

Em Ea Current Temperature: 23.859C

= Auto-Baro

REFRESH MEASUREMENTS
dipper-Log 128+: B31413

> # Example Project #2
DRIFT COMPENSATION UTILITY ZERO LOGGER

* Software Settings

(:) CONNECT VIEW ALL

Clear & Remove Device From Project

This will erase all recorded data points on this device and unlink it from the
project. This will NOT delete the data stored in the software. Once this is
done, the device can be used in a different project. Would you like 1o
continue?

CLEAR & REMOVE FROM PROJECT CANCEL
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Auto-Baro

Auto-Baro is a free, internet-connected service that automatically collects barometric data from nearby
weather stations. It uses barometric pressure datasets that best match your chosen location to adjust
your dipperLog readings for barometric pressure. When reliable data is available, Auto-Baro can improve
the accuracy of your measurements without the need for extra equipment or added effort. The Auto-
Baro data updates automatically whenever you're connected to the internet.

Selecting a Location

The Auto-Baro feature is specific to the deployment (i.e. you can have different Auto-Baro locations for
different deployments). However, all devices in one deployment will have the same Auto-Baro location.
If one device’s location is changed, the location of all other devices in that deployment will be updated.

Setting the Location When Starting a New Mission

Select your device and go to the Settings tab. Click on the SELECT LOCATION FOR AUTOMATIC BARO
COMPENSATION button. Select one of your recent locations or click on NEW LOCATION.

Sort By: Date Modified ¥ v Q overview Realtime

Resources
~ ¥ Connected
v
# barlog 64: A15761
O Help
M0 Catalog

Projects

© Add New Project Distance to Datum
> M Example Project

> A Example Project #2

Distance to Water

0 ft =
Depth

Submerged Depth of Water
Total Depth (optional) ) P

0 ft =

Immediate start () Future start

ﬂ Software Settings The dipper-Log will take a reading every

) CONNECT VIEW ALL
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Select Location for Automatic Baro Compensation

Recent

‘*’ Toronto, ON
43.64°N, -79.39°W 270ft asl

‘*. Hamilton, ON
43.29°N, -80.00°W 832ft asl

‘*. Hamilton, ON
43.29°N, -80.00°W 832ft asl

NEW LOCATION

If selecting a new location, start typing the address of your deployment location and select an option
from the dropdown menu. The coordinates will populate in the lower right-hand corner, then click SAVE.

Select your recently added location and click SAVE. Your deployment location will now be displayed on
the Settings tab.

New Location

447 Moxley Road

7 447 Moxley Road Hamilton, ON. Canada l}
¢ 447 Moxley Road Hawesville, KY, USA

447 Moxley Road Liberty, KY, USA
¥ 447 Moxley Road Bainbridge, OH, USA

7 447 Moxley Road Hays. NC. USA

powered by Google|

’. Hamilton, ON cANcEL
43.29°N, -80.00°W 823ft asl
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ﬂ Heron Instruments -

Sort By: Date Modified ¢+ + Q,

Resources Device Setup

~ @ Cconnected

# bar-Log 64: A15761

e
dipper-Log 128+: B31413 Example Project Deployment #1

Project Name Deployment Name

@ Help
I catalog
[] Override Default Time Settings
Projects Time Zone
© Add New Project New (EDT -4:00

> A Example Project

SELECT LOCATION FOR AUTOMATIC BARO COMPENSATION

‘ Hamilton, ON
43.29°N, -80.00°W 832ft asl

Overview Data Realtime

Setting the Location After the Mission Has Started

In the data management panel, navigate to your desired deployment. Click on Auto-Baro and then the

Settings tab.

Sort By: Date Modified + ~ Q overview pata

BHSnRinE Select Location for Automatic Baro Compensation

v @ Connected

# dipper-Log 128+: B31413 ‘ Hamilton, ON
/' bar-Log 64: A15761 43.20°N,-80.00°W 832ft asl

Q Help Recent
I catalog ‘ Toronto, ON

o 43.64°N, -79.39°W 270ft asl
Projects

‘ Hamilton, ON

© Add New Project 43.20°N,-80.00°W 832ft asl

v A Example Project
© Add Deployment NEW LOCATION
> Q@ Heron Water Well
v 9 Deployment #1
B notes
B Manual Entry
=3 Auto-Baro
# barLog 64: A15761
/' dipper-Log 128+ B31413
> A& Example Project #2

0 Software Settings

) CONNECT

VIEW ALL

Select one of your recent locations or add a new location. The current location is the one at the top of

the list (above the Recent header).
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Auto-Baro Data Tab

The Auto-Baro Data tab is similar to the Data tab for any logger. It displays a chart and graph along with
the same filter features and tools. For instructions on modifying and exporting the chart/graph, filtering,
and more tools please see the Viewing and Refining the Data chapter.

Sort By: Date Modified ¥ v Q Settings

Overview Data

Resources Deployment #1 auto-baro plot

34.0000
~ @ Connected

/' dipper-Log 128+ B31413
/' bar-Log 64: A15761
@ Help

W] catalog 33.0000

Projects

Total Pressure (ftH20)

@ Add New Project

~ # Example Project

© Add Deployment 32 0000

> @ Heron Water well 12/1/2024 2/1/2025 4112025 6/1/2025 8/1/2025
v @ Deployment #1 SELECT DATA RANGE | | MORE TOOLS Data v | as | CSV ~
B otes # Date & Time Total Pressure v | ftH20 ~ .
B Manual Entry 1 11/26/2024 11:00:00am 32.84394
=2 Auto-Baro 2 11/26/2024 12:00:00pm 32.84394
7 bar-Log 64 A15761 3 11/26/2024 1:00:00pm 32.84394
. 4 11/26/2024 2:00:00pm 32.86066
o dllgpEnley 1 R 5 11/26/2024 3:00:00pm 32.87405
> & Example Project #2 6 11/26/2024 4:00:00pm 32.87739
7 11/26/2024 5:00:00pm 32.89747
8 11/26/2024 6:00:00pm 32.90416
9 11/26/2024 7:00:00pm 32.90750
10 11/26/2024 8:00:00pm 32.89747
11 11/26/2024 9:00:00pm 32.89077
% software Settings 12 11/26/2024 10:00:000m 32.89412

¢ CONNECT

VIEW ALL

Upon initialization, Auto-Baro will download barometric data up to the oldest data point across all
devices in the deployment. Auto-Baro takes one reading per hour and updates the Data tab every time
it connects to the internet. This data is stored in the software’s database.
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Applying Auto-Baro for Data Compensation

Select your device and open the Data tab. Click on the Select bar-Log button and choose Auto-Baro from
the dropdown list.

SortBy: Date Modified v = Q Overview Data Realtime Settings
Resources Deployment #1 dipper-Log 128+ plot
30.000 40.0000
v ¥ Connected
# dipper-Log 128+ B31413
# bar-Log 64: A15761 5
5 20000 | g
@ Help £ z
K Catalog 5 20.0000
Projects E 10.000
@ Add New Project =
~ A Example Project
@ Add Deployment 0.000 0.0000
» ©Q Heron Water well 1/1/1970, /111981 51111992 7112003 9/1/2014
vl 9 DED|D)’!’HEHI #] SELECT DATA RANGE Select baf'LOQ - MORE TOOLS Data as CSV ~
B notes # Date & None Total Pressure ~ | @ | ftH20 ~ |} Temperature| °C ~ | [}
B Manual Entry 1 8/5 | 32.84346 24.352
= Auto-garo 2 8/5 | 32.83988 24.359
/' bar-Log 64: A15761 3 8/3] | 32.84348 24.359
4 8/3 32.84346 24.359
5 g/5 A15761 | 32.83988 24.359
> A Example Project #2 6 8/5 i 32.83988 24,359
7 8/5 Otherbar-log's | 32.83988 24,367
8 8."5_ | 32.84346 24.367
9 g/5 EmterValue | 32.83988 24.367
10 8/5rzvzo murripnr 32.83988 24.367
11 8/5/2025 2:46:13pm 32.83988 24375
& software settings 12 8/5/2025 2:46:150m 32.83988 24375
) CONNECT VIEW ALL

The field box will indicate that Auto-Baro is being used as a source for barometric pressure.

wugU T wouay

1/1/1970 3/1/1981
SELECT DATA RANGE Auto-Baro ~ MORE TOOLS

# Date & Time Totd
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Manual Entry

Within every deployment there is a Manual Entry tab. It allows you to manually add data points
collected using a water level meter. These can then be used to adjust logger readings in the Data tab.

For instructions on modifying and exporting the chart/graph, filtering, and more tools please see the
Viewing and Refining the Data chapter.

Sort By: Date Modified + «

Resources

v ¥ Connected
# dipper-Log 128+ B31413
# barlog 64: A15761

@ Help

M catalog

Projects

@ Add New Project
~ A Example Project
@ Add Deployment
> @ Heron water well
v Q Deployment #1
B Notes
B Manual Entry
= Auto-Baro
/' bar-Log 64: A15761
# dipper-Log 128+ B31413
> A Example Project #2

# Software Settings

¢ CONNECT

Data
1.000 0.0000
— £
(S P
. Zz
z
2 E
< 0500 | g 05000
] g
[=]
0.000 1.0000

SELECT DATA RANGE

8/7/2025 1:59:00pm
MORE TOOLS

# Date & Time

Deployment #1 manual entry plot

ADD DATA POINT

Distance to Water «

2

8/7/2025 2:00:00pm

Data v @as| CSV -

ft = . Temperature

QC_.

VIEW ALL
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Adding Data Points

To add a data point, click on the ADD DATA POINT button. Select the parameter (Distance to Water or

Temperature), enter the value, and input the timestamp. Press ADD DATA POINT to add it to the
database.

Sort By: Date Modified v v Q|

Resources

Deployment #1 manual entry plot

1.000 0.0000
v @ Connected

# dipper-Log 128+: B31413
# bar-Log 64: A15761

@ Help

A catalog

0.500 0.5000

Temperature ("C)

Projects

Distance to Waler (ff)

© Add New Project
~ & Example Project

© Add Deployment

0.000 1.0000
> ° Heron Water Well 8/7/2025 1:59:00pg 8/7/2025 2:00:00pm
v 9 Deployment #1 SELECT DATARANGE | = MORE TOOLS Data v | as| CSV «
B notes # Date & Time PR | Temperature| °C ~ [l

=3 Auto-Baro

# bar-Log 64: A15761

# dipper-Log 128+: B31413
> A Example Project #2

0 Software Settings

¢) CONNECT

VIEW ALL

Add Data Point

Distance to Water

Recorded At
8/7/2025 02:26:00pm

CANCEL ADD DATA POINT

Date & Time Distance to Water « 0 U m - - ¥ Temperature °C = -
- 8/7/2025226:00pm 20000 |
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Note: Data can only be input for one parameter at a time. Therefore, to add a datapoint with both
parameters, repeat the process — now selecting the other parameter. Ensure that the timestamps match
to create one single datapoint.

Add Data Point

Temperature

ed At

Recorded At
[ 8/7/2025 02:26:00pm

CANCEL ADD DATA POINT

# Date & Time Distance to Water = Q U m - - Temperature °C =

L B8/7/2025226:00pm

Note: Adding additional entries with the same timestamp will overwrite existing ones. Therefore, data
points must be at least one minute apart (as you cannot edit the seconds in the timestamp).

Adjusting Logger Data to Match Manually Entered Data

Once you've entered your manual data, the software uses it to adjust the logger readings. It identifies
the two closest data points in time—one from the manual data and one from the logger. Then it
calculates the difference between their values and applies that difference as a shift to all logger data.

For example:
Timestamp Distance to Water
Logger 8/7/2025 03:05:15pm Im
Manual Entry 8/7/2025 03:05:00pm 8m

The software identified these two data points were the closest in time. Therefore, 1m would be
subtracted from all the Distance to Water values in the logger dataset.

See the More Tools section on how to apply this adjustment.
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Other Features and Tools

Drift Compensation

Drift Compensation is a basic correction tool for pressure transducers that may have experienced drift
over time. It is also used for achieving higher accuracy in extremely low water level conditions. This
feature is only available when the logger is connected.

Select the device and go to the Overview tab. Click on the DRIFT COMPENSATION UTILITY.

Sort By: Date Modified ¢ ~  Q Overview Data Realtime Settings

Resources

w ¥ Connected
# dipper-Log 128+ B31413
# barlog 64: A15761

@ Add New Project

~ & Example Project
© Add Deployment
> @ Heron water well
v 9 Deployment #1

/' bar-Log 64: A15761

dipper-Log 128+: B31413

> 1 Example Project #2

* Software Settings

¢ CONNECT

4 DOWNLOAD ~  m ST0F | (® CLEAR & REMOVE DEVICE FROM PROJECT
Device Information

Device: dipper-Log 128+

@ Help Serial # B31413
M1 catalog Range: 32.8ftH20

Max Data Sets: 128,000
Projects

Battery Lifespan: 100%

Memory Usage: 0%

Total Readings: 87 / 128,000
Status: Not on a mission
Last Mission Started: 8/7/2025 at 1:46pm

B notes

Current Pressure: 32.78611ftH20
B Vanual Entry Current Temperature: 23.469C
= Auto-Baro

REFRESH MEASUREMENTS

DRIFT COMPENSATION UTILITY ZERO LOGGER

VIEW ALL
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Configuring the Tool

To configure the tool, you will need two data points that you can accurately expose your logger to while
taking a real-time reading. Both values must be in the logger’s original range.

In the Actual Value column, enter the values the logger is expected to provide. In the Device Value
column, enter the values currently being recorded by the device. The graph will reflect the
transformations needed. Press SYNC NOW to save your changes.

Drift Compensation

Actual Value Device Value

Point 1 1.2

Point 2 5 54

Actual Value

Realtime calibrated reading 0.04342ftH20

Last synchronized: 8/6/2025 at 11:20am m ] :
2

Indicated Value

If you need to make changes to the tool, click on DRIFT COMPENSATION UTILITY; your previous values
will still be displayed. Update them as necessary and press SYNC NOW.
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Applying the Drift Compensation to Your Data

Navigate to the Data tab and press MORE TOOLS. Check the Drift Compensation box and click UPDATE to
apply it to your data. You can also configure the tool from the MORE TOOLS menu by clicking on

Confiqure.

More Tools

[ override Default Time Settings

New York EDT -4:0C

Drift Compensation

O Averageevery 5 readings
Use | First reading timestamp

Pressure Offset

None

Pressure Multiplier

None

Backup Barometric Value: 32.24123ftH20

CANCEL | UPDATE

This tool is ideal to use for shallow deployment compensation. If you plan on using this feature regularly,
we recommend purchasing a direct read cable to conveniently get readings from discrete levels.
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Multi-Device Download

Multi-device download is available to help you save time—especially if you have 100+ loggers in a
project. A separate PC-communication cable is required for every device as well as a USB port to connect

to your computer. Plug in all your devices and press the CONNECT button. Your devices should appear
under Connected in the data management panel.

Sort By: Date Modified v~ Q Overview Data Realtime Settings

Resources # DOWNLOAD | = m STOP | | (® CLEAR

~ @ Connected

. Device Information
# dipper-Log 128+: B31413

@ Help Serial #: A15761
I catalog Range: Barometric Pressure
Max Data Sets: 64,000

Projects

© Add New Project Battery Lifespan: 100%

> A Example Project Memory Usage: 0%

> % Example Project #2 Total Readings: 0 / 64,000

Status: Not on a mission
Last Mission Started: Not available

Current Pressure: 33.18663ftH20
Current Temperature: 23.813C

REFRESH MEASUREMENTS

# Software Settings

|w’:) CONNECT | VIEW ALL

Click VIEW ALL in the bottom right-hand corner of the screen. This will display a window with all your
devices and their statuses.

Sort By: Date Modified v v Q

Overview Data Realtime Settings

Resources 4 DOWNLOAD | = B STOP (® CLEAR

v @ Cconnected

. Device Information
# dipper-Log 128+ B31413

Device: bar-Log 64

@ Help Serial # A15761

I Catalog Range: Barometric Pressure
Max Data Sets: 64,000

Projects

Battery Lifespan: 100%
© Add New Project o i

> A Example Project Memory Usage: 0%
> ¥ Example Project #2 Total Readings: 0 / 64,000

Status: Not on a mission
Last Mission Started: Not available

Current Pressure: 33.18663ftH20
Current Temperature: 23.813C

REFRESH MEASUREMENTS

* Software Settings

(:) CONNECT VIEW ALL
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Click DOWNLOAD ALL CONNECTED DEVICES and your data will begin downloading from all your devices.

DOWNLOAD ALL CONNECTED DEVICES

dipper-Log 128+: B31413

bar-Log 64: A15761

While you wait
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Zeroing the Logger

Zeroing a logger is a way to account for barometric pressure without a separate barometric pressure

source, like a bar-Log. When zeroing a logger, a pressure reading is taken and stored in a separate

section of the logger. This reading is called the back-up or programmed value. It can be used as the

barometric pressure for data compensation or pressure offsets if no barometric pressure source is

selected (e.g. Auto-Baro or a bar-Log). See Barometric Pressure Compensation for more information. It is
always recommended to zero your logger as a back-up procedure.

Ensure your logger is connected to the computer and not submerged underwater (must be in air only).
Select your logger and go to the Overview tab. Click on ZERO LOGGER.

Sort By: Date Modified ¥+ «

Resources

~ @ Connected
# dipper-Log 128+: B31413
# barLog 64: A15761

© Help

W Catalog

Projects
© Add New Project
v A Example Project
© Add Deployment
> @ Heron Water Well
~ @ Deployment #1
B notes
B Manual Entry
= Auto-Baro
# bar-Log 64: A15761
i
> M Example Project #2

* Software Settings

(:) CONNECT

Data Realtime Settings
¥ DOWNLOAD - @ CLEAR & REMOVE DEVICE FROM PROJECT
Device Information

Device: dipper-Log 128+
Serial #:B31413

Range: 32.8ftH20

Max Data Sets: 128,000

Battery Lifespan: 100%

Memory Usage: 0%

Total Readings: 87 / 128,000
Status: Not on a mission
Last Mission Started: 8/7/2025 at 1:46pm

Current Pressure: 32.67498ftH20
Current Temperature; 22.594C

[]

VIEW ALL

The barometric pressure value stored from zeroing the logger can be viewed after your data has been

downloaded. Go to the Data tab and click on MORE TOOLS. The value is named as the “Backup
Barometric Value.”
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SortBy: Date Modified v = Q Overview | Data Realtime Settings
Resources Deployment #1 dipper-Log 128+ plot
24,150 0.0000
v ¥ Connected
/' dipper-Log 128+ B31413
/' barLog 64: A15761 g
S 24100 | £
@ Help < =
W catalog % 2 0.0020 81112025 10:23;
T E [ Dert s, hn2s jed (tH20): -0.00
Projects E 24050 : []Temperz ure (" Z): 24.086
© Add New Project a
v A Example Project
© Add Deployment 24000 | -0.0040
> @ Heron water well 8/11/2025 10 22 00am /1112025 10-23-00am /112025 10 24:00am
v @ Deployment #1 SELECT DATA RANGE | | Select bar-Log ~ ||| MoRe TOOLS | Data ~  as| CSV =
B notes # Date & Time Depth Submerged ~ | @ | ftH20 + . Temperature  °C = .
B Wanual Entry 1 8/11/2025 10:21:57am 0.00000 24.016
= Auto-Baro 2 8/11/2025 10:22:02am -0.00358 24.023
3 8/11/2025 10:22:07am -0.00358 24.023
5 O T 4 8/11/2025 10:22:12am -0.00358 24.031
R 5 8/11/2025 10:22:17am -0.00358 24.039
6 8/11/2025 10:22:22am -0.00358 24.039
7 8/11/2025 10:22:27am 0.00000 24.055
8 8/11/202510:22:32am 0.00000 24.055
9 8/11/202510:22:37am 0.00000 24.055
10 8/11/202510:22:42am -0.00358 24.063
11 8/11/202510:22:47am -0.00358 24.063
% software Settings 12 8/11/2025 10:22:52am 0.00358 24.070
) CONNECT VIEW ALL

More Tools

Pressure Offset

None

Pressure Multiplier

None

| Backup Barometric Value: 32.66781fH20 |

< Distance to Water
Distance to Datum

2 ft «

. Depth
Submerged

Total Depth (optional) «— Depth of Water

0 ft «

e

[0 override Decimal Places for Pressure

[ override Decimal Places for Temperature

CANCEL  UPDATE
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Restoring the Example Project

The Example Project included when the software is first downloaded can be restored or reset at any
time. Go to Software Settings, Advanced tab and then click on RESTORE EXAMPLE PROJECT. Note: if you
have added data to the Example Project, it will be deleted.

Sort By: Date Modified ¥ ~ Q, Version 8.1.39

Resources Software Settings
~ . Connected
# dipper-Log 128+: B31413 Export Database = CHOOSE LOCATION
# bar-Log 64: A15761 Import and Merge Database = SELECT FILE
@ Help
I Catalog Pressure Column Default Raw Device Pressure -

Projects Data Export Options  All Column Options (Default) «
° Add New Project
> Y TestProject #1

Exported Date and Time  \jerged (Default) «

Filename Format Example Filename *123456_2025-08-11_0936am_data_Tutorial"

e Logger Serial Number -
e Date of file creation «

(-] Type of data (Data/Graph) ~

e Custom Text « Tutorial

ADD ITEM

Tools RESTORE EXAMPLE PROJECT DRIVER INSTALLATION

u Software Settings

¢y CONNECT VIEW ALL

Once restored, the Example Project will be visible in the Data Management Panel.

Sort By: Date Modified + = Q, Version 8.1.39

Resources Software Settings
~ @ Connected

# dipper-Log 128+: B31413

Export Database = CHOOSE LOCATION

# barlog 64: A15761 Import and Merge Database = SELECT FILE
Q Help
K catalog Pressure Column Default Raw Device Pressure «
Projects Data Export Options  All Column Options (Default) «

° Add New Project
> M TestProject #1

> # Example Project

Exported Date and Time  jerged (Default) =

Filename Format Example Filename "123456_2025-08-11_0947am_data_Tutorial"

e Logger Serial Number -
e Date of file creation «

-] Type of data (Data/Graph) ~

e Custom Text « Tutorial

ADD ITEM

Tools RESTORE EXAMPLE PROJECT DRIVER INSTALLATION

¢y CONNECT VIEW ALL
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Driver Installation

To install drivers, go to Software Settings, Advanced tab and click on DRIVER INSTALLATION. A window
will appear indicating if you are missing any drivers. Click INSTALL and follow the on-screen steps similar
to the initial software installation.

In the pop-up window you are also able to click on ADVANCED. Follow the on-screen instructions. To
install drivers with no internet connection, click on OFFLINE DRIVE INSTALLATION.

Sort By: Date Modified ¢ ~ Q Basic I T | Version 8.1.39

Resources Software Settings
~ ¥ Connected

/' dipper-Log 128+: B31413 Export Database = CHOOSE LOCATION

# bar-Log 64: A15761 Import and Merge Database | SELECT FILE
@ Help
M1 catalog Pressure Column Default Raw Device Pressure «

Projects Data Export Options  All Column Options (Default)
© Add New Project

> 1 TestProject #1
> # Example Project

Exported Date and Time  Merged (Default) «

Filename Format Example Filename "123456_2025-08-11_0956am_data"

Logger Serial Number
Date of file creation +

Type of data (Data/Graph) ~

ADD ITEM

Tools RESTORE EXAMPLE PROJECT DRIVER INSTALLATION

* Software Settings

(:) CONNECT VIEW ALL

Driver Installation

Your system is missing a driver required by the communication cable.

Please plug in communication cable and click install.

ADVANCED INSTALL
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Changing the Default Settings

To change the default software settings, click on Software Settings in the bottom left-hand corner of the
screen.

SortBy: Date Modified v = Q Overview Data Realtime Settings

Resources # DOWNLOAD ~ H STOP () CLEAR & REMOVE DEVICE FROM PROJECT

v ¥ Connected

. Device Information
# dipper-Log 128+: B31413

#" bar-Log 64: A15761 Device: dipper-Log 128+
@ Hep Serial #: B31413
I catalog Range: 32.8ftH20

Max Data Sets: 128,000
Projects

Battery Lifespan: 100%
@ Add New Project v =

v A Example Project Memory Usage: 0%

© Add Deployment Total Readings: 87 / 128,000

> @ Heron Water Well Status: Not on a mission

~ @ Deployment #1 Last Mission Started: 8/7/2025 at 1:46pm
B notes
5 Current Pressure: 32.67498ftH20

Ml Es Current Temperature: 22.594C

=2 Auto-Baro

/ barLog 64: A15761 REFRESH MEASUREMENTS
ar-Log 64:

dipper-Log 128+: B31413
DRIFT COMPENSATION UTILITY ZERO LOGGER

> A& Example Project #2

|¢ Software Settings I

w’:) CONNECT VIEW ALL
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Basic Settings

In the Basic tab, you can change the default units, decimal symbol, digit group symbol, date and time
formats, and the language, suitable for your region. Use the dropdown arrows to view the options and
make your selection.

Sort By: Date Modified ¢ v Q Advanced Version 8.1.39

Resources Software Settings
~ @ Connected

# dipper-Log 128+ B31413 Default Distance Unit  ft «

# barLog 64: A15761 Default Pressure Unit  fiH?0 «
@ Help Default Temperature Unit °C =
M catalog
s Decimal Symbol . ~
© Add New Project Digit Grouping Symbol , ~

> A Example Project

> # Example Project #2 Date Format M/D/YYYY (Custom) +

Time Format 12 hr ~

Time Zone United States of America v New York (EDT-4:00) =  Daylight Savings: Automatic «

Language English =

* Software Settings

(:) CONNECT VIEW ALL
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Advanced Settings

In the Advanced tab, you can change the default:

Pressure Column Parameter

Use the dropdown to select the default pressure parameter that is displayed.

Version 8.1.39

Resolices Software Settings
v ¥ Connected

/" dipperLog 128+ B31413 Export Database | CHOOSE LOCATION

' barlog 64: A15761 Import and Merge Database = SELECT FILE
@ Help
K] Catalog Pressure Column Default | Raw Device Pressure «
Projects Data Export Options  All R (S (FESEE
© Add New Project | Depth Submerged

Exported Date and Time

> M TestProject #1 | Distance to Water

> M TestProject #2
Filename Format  Exanf Depth of Water $11_0844am_data"

Logger Serial Number «

Date of file creation «

Type of data (Data/Graph) =
ADD ITEM

Tools RESTORE EXAMPLE PROJECT DRIVER INSTALLATION

n Software Settings

) CONNECT

VIEW ALL
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Data Export Mode

There are 3 options for how your data is exported:

e All Column Options (Default): Exports the data chart with additional columns for all
dropdown options. E.g. the exported chart would include a column for all the pressure
parameters (Total Pressure, Depth Submerged, Distance to Water, and Depth of Water).

e Contextual: Exports the chart with only the selected dropdown parameter.

e Legacy: Exports the data in the same format as the old software.

Sort By: Date Modified ¥ ~

Resources

v @ connected
# dipper-Log 128+: B31413
# bar-Log 64: A15761

@ Help

0 catalog

Projects

Add New Project
> A Test Project #1
> A TestProject #2

() CONNECT

Q

Basic

Software Settings

Export Database

Import and Merge Database

Pressure Column Default Raw Device Pressure ~

Data Export Options}

Exported Date and T|

Filename Format

r

All Column Options (Default) ~

All Column Options (Default)
Contextual

Legacy

| 0936am_data_Tutorial’

Tools

Date of file creation ~

Type of data (Data/Graph)

Custom Text v | Tutoria

Version 8.1.39

VIEW ALL

Exported Date and Time Format

There are 2 options for how the date and time are exported:

e Merged (Default): The date and time are combined and displayed in a single column.
e Separated: The date and time are split and displayed in two different columns.

odified ¥ +

Sort By: Date M

Resources

v @ Connected
/" dipper-Log 128+: B31413
/' barlog 64: A15761

@ Help

0 catalog

Projects

© Add New Project
> A Test Project #1
> & Test Project #2

) CONNECT

Q

Basic

Software Settings

Export Database

Import and Merge Database

Pressure Column Default Raw

Device Pressure +

Data Export Options  All Column Options (Default) +

Exported Date and Time | Merged (Default)

Filename Format

Tools

Exa

Merged (Default)

Separated L -

Date of file creation ~

Type of data (Data/Graph)

25-08-11_0907am_data"

Version 8.1.39

VIEW ALL
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Changing the Default Filename Format

The default filename format is fully customizable. Use the dropdown arrows to select different
items you want to include in the file name. The items will be displayed in the order you have
selected them, separated by an underscore. The Example Filename is a preview line that will
update as you make changes.

Resources Software Settings

v @ Connected

/' dipper-Log 128+ B31413 Export Database | CHOOSE LOCATION

# bar-Log 64: A15761 Import and Merge Database = SELECTFILE
@ Help
K0 catalog Pressure Column Default Raw Device Pressure «
Projects Data Export Options  All Column Options (Default) ~
@ Add New Project
S A Test Project #1 Exported Date and Time  \Merged (Default) -

> M TestProject #2
Filename Format I Example Filename "123456_2025-08-11_0918am_data’ I

Logger Serial Number +
Date of file creation ~

Type of data (Data/Graph) ~

ADD ITEM

Tools RESTORE EXAMPLE PROJECT DRIVER INSTALLATION

* Software Settings
f:) CONNECT VIEW ALL

Add items using the ADD ITEM button and remove items by clicking on the (-) button. Note that
a minimum of three items is required. To add custom text to the filename, click on the desired
item dropdown and select Custom Text. In the field box type your desired text.

Filename Format Example Filename "123456_2025-08-11_0921am_data_Tutorial’

e Logger Serial Number

e Date of file creation «

e Type of data (Data/Graph) -

@ CustomText v | Tytorial |
ADD ITEM |
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